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Chapter 1. Introduction
Geeqie is an image viewer that makes navigation of images easy. Images can be viewed as thumbnails,
in multiple windows or in full screen mode.

Geeqie is an image manager, with complete copy, move, rename, and delete functions available at
the press of a button.

Extensive image collections can be easily handled using a combination of Geeqie's flexible Keyword
facility and powerful Image searches.

Image collections can be refined with a duplicate image finder.

Geeqie is ideal for making presentations. A slide-show feature is built in, and Geeqie can be remotely
controlled either via command line scripts or an infra-red device. Information such as f-stop, shutter
speed and descriptive text can be overlaid onto the image display.

There is no need to import images into Geeqie - simply point Geeqie to a folder containing images,
and your data will be displayed.

Geeqie is an image viewer, not an image editor. However, Geeqie can be configured to call external
image editors such as the Gimp, resulting in a very powerful combination.

Features

Basic Features
• Icon view
• Full Screen
• Slide Show
• File Management
• Collections

Advanced Features
• Search and Select

Image Search based on many parameters
• Finding Duplicates

Find image duplicates based on image content
• List panes

View IPTC, and view and edit Exif and XMP data stored in images
• Sort Manager Sidebar

Simple Sort Manager to quickly sort a folder of images into other folders
• Rename

Rename images in bulk
• Image Overlay

Overlay the image with a panel showing user-definable data
• Keywords

Add XMP keywords to images, and recall those images with the search function
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Introduction

• Preferences

Geeqie is a very configurable application

“An application that displays images.” - This was, and still is, the primary goal of Geeqie. Over time
image management features have been added, but the core purpose of Geeqie remains the same.
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Main Window

      

Table 2.1. 

                  Layout window
                  Title bar
                  Tools
                  Main menu
                  Main toolbar
               

                  Location bar
                  Shortcuts pane
                  Folders pane
                  Files pane
               

                  Image pane
                  Info sidebar (optional)
                  Sort manager (optional)
                  Status bar
                  Status toolbar
             

    

The Geeqie main window is designed for quick and easy navigation of images. The window consists
of three regions: the File Pane , the Folder pane , and the Image Pane (optionally bordered by Sidebars
) , all bordered by Menus and Status Bar .

Multiple instances of the main window may be started via the Windows → New Window (Ctrl+N)
menu item, and the Layout of each may be individually configured in the Window Layout dialogue.

If several instances of the main window are open, they may be closed individually or simultaneously.
If File → Quit (Ctrl+Q) is pressed, all windows will be closed. When Geeqie is re-opened the same
windows will be re-displayed.

If Windows → Close Window (Ctrl+W) is pressed, only that window will be closed unless that win-
dow is the "main" window, in which case all windows will be closed. When Geeqie is restarted only
the main window will be displayed.

The main window may be recognised by the word "Geeqie" in the title bar, as opposed to other win-
dows which have the word "geeqie".

Several window layouts may be defined and displayed at any time, as described in the Windows menu .

File Pane
The file pane displays the images contained in the active folder. It has two modes of display, allows
multiple selection, and can initiate drag and drop operations.

A context menu can be displayed by clicking the right mouse button on the file pane or pressing the
menu key while the file pane has the focus.

List view
This mode can be enabled by selecting List from the View menu, pressing Ctrl + L, or unselecting
View as icons from the context menu.

The list view mode displays images in a standard vertical list. Three columns provide the file name,
size in bytes, and the time the contents were last modified.

Thumbnails can be displayed next to each file in the list, to toggle thumbnails on or off by select-

ing Thumbnails from the View menu, pressing T, clicking  on the tool bar, or selecting Show
thumbnails from the context menu.

Grouped sidecar files are represented by the main file with an expander. Clicking on the expander
shows sidecar files.

4
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Icon view
This mode can be enabled by selecting Icons from the View menu, pressing Ctrl + I, or selecting
View as icons from the context menu.

The icon view mode displays images as thumbnails in a grid, and by default a file name below each
thumbnail.

The file name displayed below each thumbnail can be turned on or off by selecting Show filename
text from the context menu.

Grouped sidecar files are represented by the main file. For accessing sidecars switch to List mode.

File Filter
A filter box can be opened by selecting Show File Filter from the View menu.

Characters you type into this box will be used for pattern matching to select the files displayed. Regular
expressions are used in this field.

For basic pattern matching "JPG" will match any filename containing those characters.

If you type a newline, the text will be saved in the dropdown box list. The last 10 items are saved.

To delete an item, select it from the drop-down list, click on the text box to select the text, and then
press Delete followed by Enter .

By default filtering is case-insensitive. A checkbox labelled "Case" permits the filter to be made case-
sensitive.

Additionally a drop-down box permits any of the file Classes to be selected or deselected from the
viewed list.

Multiple selection
It is possible to select more than one image from the file pane. Multiple files can be selected with
several methods:

Mouse

• Ctrl + Primary mouse button will add or remove the file from the selection.
• Middle mouse button will toggle selection of the file.
• Shift + Primary mouse button will select all images between the clicked and focused image, or

it will unselect all those images if the clicked image is already selected.
• Shift + Ctrl + Primary mouse button works as Shift + Primary mouse button, but will not

change the selection of files outside the region between the focus and clicked image.

Keyboard

• Ctrl + Arrows will move the focus without changing the selection.
• Ctrl + Space will toggle selection of the focused image.
• Shift + Arrows will select a region of images.
• Shift + Ctrl + Arrows works as Shift + Arrows, but will not change the selection

of files outside the current focus region.
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To select all files press Ctrl + A, or to unselect all image press Ctrl + Shift + A. These
operations are also available from the Edit menu as Select all and Select none .

The current number of selected images and their total size will be indicated in the File list section of
the status bar .

Sorting
The order of the images can be changed by clicking the sort area of the status bar or from the context
menu. The sort methods are by file name, number, file date, or file size. The number method will
sort file names by their natural order, for example files with names of file_10, file_12, and file_9 will
appear in order file_9, file_10, and file_12.

Selecting the ascending menu item will toggle between increasing and decreasing sort order.

Context menu
Right clicking the mouse or pressing the menu key while the file pane has focus will display a menu.
The menu functions will perform the same as those that match the window's menu bar , however a
few functions are unique to the context menu:

View in new window Opens a new window containing a list of the currently selected
images.

Sort Changes the sort order of file pane.

View as icons Toggles between the list and icon view modes.

Show thumbnails Toggles display of thumbnails in the list view display mode.

Show filename text Toggles display of file names in the icon view display mode.

Show star rating Toggles display of the "star rating" (Xmp.xmp.Rating).

Drag and Drop
Drag and drop can be initialized with the primary or middle mouse buttons in the file pane. Dragging
a file that is selected will include all selected files in the drag. Dragging a file that is not selected will
first change the selection to the dragged file, and clear the previous selection.

Folder pane
The folder pane contains the menu bar, tool bar, path entry, and folder list.

Menu bar
The main menu of the window. The functions available from the main menu are described in the
Menus chapter.

Tool bar
The tool bar includes buttons for often used operations. The tool bar can be hidden or shown by
selecting Hide toolbar from the View menu.
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Table 2.2. Tool bar

Icon Tooltip Description

Show thumbnails This button is active when the
file list is in list view mode, and
activating it will toggle the dis-
play of thumbnails.

Back Move back in folder history

Up Move up one folder

Home Change the main window to dis-
play the contents of the user's
home folder

Refresh folder display Refresh the contents of the file
pane

Zoom in Increase the image display size.

Zoom out Decrease the image display size.

Zoom to fit This will size the image to fit
within the window

Zoom 1:1 Restore zoom to the image's
original size.

Preferences Displays the Preferences win-
dow .

Float file list Toggle the folder pane, file pane,
and status bar between the main
window and a secondary win-
dow.

Path entry
This displays the active folder of the window and allows typing a location.

A folder or file can be typed into the entry to quickly change to a desired location or image, the main
window will update after pressing the Enter key. Tab completion is also available in the path entry.

Note

Tab completion uses the Tab key, press the Down key to move the focus from the entry.

Next to the path entry is a button with a down arrow, clicking this will display a drop down list
containing the most recent locations viewed. The list is ordered such that the most recent location is at
the top. Selecting a location from the drop down list will change the window to display the location.

An Internet URL may be typed or drag-and-dropped into this field. The file will be downloaded to
a temporary file and displayed.
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Folder list
This pane consists of two sections: a folder pane and a shortcuts pane. The shortcuts pane may be
hidden or revealed simply by moving the vertical divider to or from the extreme left.

Folders

This displays a list of sub folders contained in the active folder, or a tree that includes all folders in
the file system.

A context menu can be displayed by clicking the right mouse button on the folder pane or pressing
the menu key while the folder pane has the focus

Shortcuts

This is a list of shortcuts (bookmarks) to commonly used folders, images and collections. A context
menu will appear by right clicking on an item, or pressing the menu key when the item has the focus.

Folders or images can be added to the list by activating the Add button at the bottom of the pane, or
dragging a folder or image onto the list.

Collections may be added by opening the File → Open collection... (O) dialog and dragging a collec-
tion onto the list.

To edit an item select Properties from its context menu. A dialog will appear allowing the Name,
Path, and Icon for the item to be changed. Select OK to close the dialog and apply the changes, or
Cancel to close the dialog and discard the changes.

To change the order of the list, select Move up or Move down from the item's context menu. To
move an item with the keyboard move the focus to that item, then press Shift+Up or Shift+Down
to move the item.

To remove an item from the list select Remove from it's context menu.

List view
This mode can be enabled by from the View menu, from the context menu, or pressing Ctrl + T .

The list view mode displays sub folders contained in the active folder in a standard vertical list. The
parent folder can be selected with the folder named “..”.

Tree view
This mode can be enabled by selecting Tree from the View menu, pressing Ctrl + T , or selecting
View as tree from the context menu.

The tree view mode displays all folders in the file system, starting with the root folder and branching
out to include sub folders. A folder branch can be expanded or collapsed by clicking the expander next
to each folder icon, or by pressing the respective + or - keys when the folder branch has the focus.

Sorting
The order of the folder names will match the order selected for the file pane. Sort order can be changed
by clicking the sort area of the status bar or from the context menu of the file pane.
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Context menu
Right clicking the mouse or pressing the menu key while the folder pane has focus will display a menu.
The menu functions will perform the same as those that match the window's menu bar , however a
few functions are unique to the context menu:

Table 2.3. Context menu

Icon Text Description

Up to parent This will change the window to
display the contents of the parent
folder.

Slide show Start a slide show that contains
all images in the selected folder.

Slide show recursive Start a slide show that contains
all images in the selected folder,
and all images in the sub folders
of that folder.

Find duplicates This will open a new find dupli-
cates window containing all im-
ages in the selected folder.

Find duplicates recursive This will open a new find dupli-
cates window containing all im-
age in the selected folder, and all
images in the sub folders of that
folder.

New folder Creates a new folder that is a sub
folder of the selected folder.

Rename Renames the selected folder.

Warning
Warning: Renaming a
folder will not up-
date metadata, such as
keywords, or cached
thumbnails for images
contained in that folder,
the data will be lost.

Delete Delete file or folder

Copy path Copy selected item-path(s) to
clipboard a . Each data item
copied will be enclosed in
quotes.

Copy path unquoted Copy selected item-path(s) to
clipboard. The data will not be
enclosed in quotes.

View as list Switches to list tree mode of the
folder pane.

View as tree Switches to tree mode of the
folder pane.
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Icon Text Description

Show hidden files Switches to list tree mode of the
folder pane.

Refresh Switches to tree mode of the
folder pane.

a The clipboard used is selected here.

Drag and drop
Image files can be dropped onto folders displayed in the folder pane. A menu will appear allowing
you to select to move or copy the dropped images into the target folder. The list will automatically
scroll up or down when the drag pointer is near the respective top or bottom of the list. When in tree
mode, hovering over a folder for a brief period of time will expand that folder.

The folders can used as a drag source for drag and drop, for example to add images in a folder to a
collection window. However drag and drop can not be used to move or copy folders in Geeqie.

Using Shift key while dragging is a shortcut to move action. Menu will not appear but move will
occur.

Using Ctrl key while dragging is a shortcut to copy action. Menu will not appear but copy will occur.

Image Pane
The image pane is the region of the main window that displays the selected image. The image pane
allows adjustment of display size and orientation; it also provides several methods to manipulate the
image with the mouse and keyboard.

Image display
The image is drawn to the screen as it is decoded from disk. The image can be panned and zoomed
while it is still loading. Image adjustment operations for rotation, mirror, and flip will delay until
the image is completed. The adjustment queue will remember one operation and will retain the most
recently requested function, which will be performed once the image has finished loading.

The quality of the image, especially when using the zoom feature, is dependent on the settings that
are available on the Image tab of the preferences dialog.

To increase the speed of loading the next image when navigating the image list in sequence, enable
the Preload next image option.

Image Overlay
An image overlay can be turned on and off by repeatedly pressing I . This overlay can either display
image data such as f-stop, shutter speed and descriptive text, or a histogram.

Data the overlay will always show is:

• Marks , if they are selected

If the histogram is being displayed, K will switch the histogram between colors, and J will toggle
between a linear or logarithmic histogram.
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Data the overlay displays is customizable through the Image Overlay Template option in the Windows
tab in the Preferences dialog.

Image panning and manipulation
When the image size is larger than the image pane, the visible region can be changed with the keyboard
or mouse. The keyboard can also be used to adjust the orientation of the image.

Keyboard and mouse

Keyboard and Mouse Shortcuts describes how you may manipulate the image displayed.

Note

The rotation, mirror, and flip functions do not change the image data, they merely change
the image as you view it. You may store the modified orientation into metadata manually
with Edit → Orientation → Apply the orientation to image content , or this may happen
automatically if Write altered image orientation to the metadata is set in Metadata Options

Mouse

Press the left mouse button on the image and hold it, then move the mouse to pan the image in the
desired direction. Releasing the mouse button will stop the panning operation. The mouse wheel can
also be used to scroll the image when holding down the Shift key 1 .

To scale the image size hold down the Ctrl key and scroll the mouse wheel up to zoom in, or down
to zoom out.

Smooth Scroll

To start the smooth scroll function hold down the Control key and click the left mouse button. An
icon will appear at the location of the mouse pointer, the mouse can then be positioned to pan the
image. The image will pan in the direction of the mouse pointer relative to the icon. The pan speed
will increase in proportion to the distance that the pointer is from the center of the icon. To end the
smooth scroll function click the left mouse button within the image pane.

Mouse Wheel Mode

A single click on the mouse middle button will toggle the function of the mouse wheel between "change
image" and "change zoom".

Note

This option cannot be used if either the Preference Mouse wheel scrolls image or Navigation
by left or middle click on image are selected.

In Split View mode, each window can be clicked individually so that, in Quad View for example,
Connected Zoom can be on 2, 3 or all 4 windows.

Navigation
The displayed image can be changed to the next or previous image using the keyboard or mouse.

1 The mouse wheel behavior for scrolling and image step can be swapped with the "Mouse wheel scrolls image" option located on the Behaviour
tab of the preferences dialog.
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Keyboard

The PageDown and PageUp keys will change the image to the next or previous image, respectively,
in the list. The Home and End keys will jump to the first and last image, respectively. When the image
has the focus, the SpaceBar and BackSpace keys can also be used to change the image.

Mouse

To change to the next image in the list click the left mouse button, click the middle mouse button to
change to the previous image. The mouse wheel can also be used to change the current image b .

Context menu
Right clicking the mouse or pressing the menu key while the image has the focus will display a menu.
The menu functions will perform the same as those that match the window's menu bar , however a
few functions are unique to the context menu:

View in new window Opens a new window containing a second copy of the current
image.

Pause slide show, Continue slide
show

Controls the pause state of an active slide show, the text of the
menu will change to reflect the action that will be performed.

Copy image to clipboard Copy the pixbuf to the clipboard. This may be used by programs
such as Gimp.

Drag and Drop
Files and folders can be dropped onto the image pane, dropping a file will display the file and dropping
a folder will change the main window to display the contents of the folder. When dropping multiple
items on the image pane, only the first item in the list will be used, all additional items will be ignored.

A drag and drop operation can be initiated from the image pane with the middle mouse button, the
dragged item will contain the file path of the displayed image.

Displaying images side by side
Using View → Split item from the main menu, image pane can be split into either two, three or four
panes, allowing one to display images side by side. You may use drag'n drop to change images in
each pane.

Connected zoom is possible through the View → Zoom → Connected Zoom menu item. Zoom is
then applied to all displayed images.

Connected scrolling is also possible using Shift and primary mouse button.

As a general rule, hotkeys and mouse without shift affects just one image and with shift all images.

Navigation
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Moving around in the file system
To select the folder containing the desired images for display, change to the image's folder using the
folder view. Single clicking a folder with the primary mouse button will change the main window to
display that folder's contents. When the folder view is displayed as a list, use the folder named “..” to
change to the parent folder (the parent folder is the folder that contains the current folder).

To select a folder with the keyboard, move the focus to the desired folder and press the Space or Enter
key.

Moving around within a folder
After selecting the desired folder as above, the desired image can be viewed by selecting it from the
file list. To select a file for display single click it with the primary mouse button.

To select a file with the keyboard, move the focus to the desired file. As you move the focus within
the file list the image display will update to match the highlighted file.

Going home
To change to your home folder, click the Home button in the tool bar. Home folder can be set in
window preferences.

Direct path entry
The current path is displayed in an entry field above the folder list. A folder or file can be typed into
the entry to quickly change to a desired location or image, the main window will update after pressing
the Enter key. Tab completion is also available in the path entry.

Next to the path entry is a button with a down arrow, clicking this will display a drop down list
containing the most recent locations viewed. The list is ordered such that the most recent location is at
the top. Selecting a location from the drop down list will change the window to display the location.

Stepping through images sequentially
To change the displayed image to next or previous one within the same folder, use the respective
PageDown and PageUp keys. The mouse can also be used to change the image by clicking the image
display with the respective primary and middle buttons.

To change to beginning or end of the image list, use the respective Home or End keys.

Menus
This section describes the functions of each item on the menu bar in the Geeqie main window.

File Menu
New window (Ctrl+N) Opens a new main window, with the initial path set to the cur-

rent folder.

New collection (C) Opens a new collection window, the new collection will be
empty.
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Open collection (O) Displays a dialog to open a collection stored on disk, the select-
ed collection will then appear in a new window.

Open recent This menu item lists the recently active collections, selecting
an item from the list will open that collection in a new window.
The most recent item will appear at the top of the list. Maxi-
mum number of entries can be modified through Open recent
list maximum size option.

Search… (F3) Opens a new Search window.

Find duplicates... (D) Opens a new Find Duplicates window.

Print.. (Shift+P) Opens a print dialog.

New folder… (Ctrl+F) Creates a new folder in the current path.

Copy… (Ctrl+C) Opens a dialog to select a destination to copy the currently se-
lected files.

Move… (Ctrl+M) Opens a dialog to select a destination to move currently selected
files.

Rename… (Ctrl+R) Renames the current file selection.

Open With... Calls the standard GTK application chooser for a single file.

Delete… (Ctrl+D) Deletes the current file selection.

Symlink Creates a symbolic link. This is implemented via a plugin .

Close window (Ctrl+W) Closes the window containing the menu, if the window is the
last main window Geeqie will quit.

Quit (Ctrl+Q) Quits the Geeqie application, if collections or image metadata
have been changed but not saved, the user will be prompted for
confirmation.

Go menu
The Page commands are for files which contain multiple images e.g. .tiff files

First Image (Home) Goes to the first image.

Previous Image (Backspace) Goes to the previous image.

Next Image (Space) Goes to the next image

Last Image (End) Goes to the last image

Image Back Each image you view is appended to a chain. You may traverse
forwards and backwards through this chain using this and the
following key. Move to the previous image in the chain.

Image Forward Move to the next image in the chain.

Back Back Goes to the previous folder

Home (Home) Goes to the the Home folder as defined in Window Layout

First Page (Ctrl+Home) Goes to the first page.
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Last Page (Ctrl+End) Goes to the last page.

Previous Page (Ctrl+PageUp) Goes to the previous page.

Next Page (Ctrl+PageDown) Goes to the next page.

Select menu
Select all (Ctrl+A) Selects all files in the current list

Select none (Ctrl+Shift+A) Deselects all files

Invert selection (Ctrl+Shift+I) Inverts current selection

Rectangular selection (Alt+R) Toggles rectangular selection mode for icons

Copy to clipboard Copy selected item-path(s) to clipboard 2 . Each data item
copied will be enclosed in quotes.

Copy to clipboard (unquoted) Copy selected item-path(s) to clipboard. The data will not be
enclosed in quotes.

Cut to clipboard (Ctrl+X) Perform a standard control-X operation.

Show marks (M) Displays marks in the file list

Clear marks Clear all marks for all images

Warning

Marks that are linked to keywords will also be cleared.
This may result in a metadata write operation being
triggered.

Mark n Opens submenu for manipulating mark n

Mark n → Toggle Mark n (n) Set or unset mark n on selected files

Mark n → Set mark n Set mark n on selected files

Mark n → Reset mark n Unset mark n on selected files

Mark n → Select mark n (Ctrl+n) Selects all files having mark n set

Mark n → Add mark n Adds files having mark n set to selection

Mark n → Intersection with mark n Intersects current selection and mark n

Mark n → Unselect mark n Removes files having mark n set from current selection

Mark n → Filter mark n Shows only the images that have mark n set.

Edit menu
Orientation Adjust image orientation

Orientation → Rotate clockwise (]) Rotates the current image clockwise 90 degrees, does not mod-
ify the file on disk.

2 The clipboard used is selected here.
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Orientation → Rotate counter-
clockwise ([)

Rotates the current image counterclockwise 90 degrees, does
not modify the file on disk.

Orientation → Rotate 180
(Shift+R)

Rotates the current image 180 degrees, does not modify the file
on disk.

Orientation → Mirror (Shift+M) Swaps the left and right sides of the image so that the result
is similar to that of looking at the image in a mirror, does not
modify the file on disk.

Orientation → Flip (Shift+F) Swaps the top and bottom sides of the image, does not modify
the file on disk.

Warning

The above orientation commands - Rotate, Mirror and
Flip - do not change the image on disk. The changes
will be lost when Geeqie closes. Refer to the Meta-
data tab of the Preferences Dialog if you wish these
changes to be written to metadata.

Refer also to the FAQ .

Orientation → Original state
(Shift+O)

Removes all temporary effects applied through the above com-
mands, reverting the image according to its Exif Orientation
tag.

Auto rotate image using EXIF in-
formation

Auto rotates images based on metadata stored in images that
have Exif data. Refer also to the FAQ .

Orientation → Apply the orienta-
tion to image content

This command affects only jpeg, tiff and png files. The image
file on disk is rotated to the orientation as specified by its Exif
Orientation tag.

Warning

The file rotate.desktop, using external commands
exiftran, exiv2 and mogrify, is used to implement this
command. Refer to Plugins section for details.

Orientation → Rotate counter-
clockwise ([)

Rotates the current image counterclockwise 90 degrees, does
not modify the file on disk.

Orientation → Rotate 180
(Shift+R)

Rotates the current image 180 degrees, does not modify the file
on disk.

Orientation → Write orientation to
file

Saves the current image orientation to the disk file. This oper-
ation can only be carried out on jpeg, tiff and png files. Jpeg
rotations are lossless.

Note
The Preferences/Metadata option "Write altered im-
age orientation to the metadata" must be off.

Exiftran and mogrify must be installed.

Orientation → Write orientation to
file (preserve timestamp)

As above, but the file date and time are preserved.

Rating Set a Rating value for each image.
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Rating → n (Alt+Keypad+n) "n" is in the range 0 to 5. Sets the Rating value for the image.

Rating → -1 (Alt+Keypad+Mi-
nus)

Sets the Rating value to -1 for the image.

Save metadata (Ctrl+S) Saves queued metadata changes. Autosave can be configured
too.

Keyword Autocomplete (Alt+K) Refer to Info Sidebar.

Draw rectangle Press and drag the mouse left button to draw a rectangle.

Aspect ratio Select an aspect ratio for the above action.

Crop rectangle Crop the image rectangle set above. See also Image Crop plu-
gin.

Preferences (Ctrl+O) Opens the Preferences Dialog for changing of global prefer-
ences.

Configure Plugins… Opens the Plugins Dialog for changing of desktop files.

Configure This window… Opens the Window Preferences Dialog for changing of options
that can differ for each window.

Cache maintenance Opens a dialog with utilities for thumbnail and keyword Cache
and Data Maintenance .

Set as wallpaper Renders the current image to the root window (desktop). The
resulting image will be tiled to fit the root window if zoom is
not set to Fit to window ; when zoom is set to Fit to window ,
the image will be scaled to fill the root window.

Plugins menu
Plugins This menu contains the plugins (desktop files) that were found

on the system. See the Plugins section for details.

View menu
View in new window (Ctrl+V) Opens selected image in its own window

Pan view (Ctrl+J) Opens current folder in Pan view window

Exif data (Ctrl+E) Toggles display of the Exif sidebar.

Files and Folders+Folder List
(Meta+L)

Set the folder view mode to list.

Files and Folders → Folder Tree
(Ctrl+T)

Set the folder view mode to tree.

Files and Folders → Image List
(Ctrl+L)

Changes the file list to display files in list format.

Files and Folders → Icons (Ctrl+I) Changes the file list to display files as icons.

Files and Folders → Show Thumb-
nails

Toggles the display of image thumbnails in the file list, this
item is not available when the file list is in icon view mode. A
check appears next to this item when thumbnails are enabled.
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Files and Folders → Float file list
(L)

Splits the 3-pane main window into two parts:

• File pane and Folder pane, along with menu and status bar

• Image pane and its associated sidebar and sort manager (if
displayed)

Files and Folders → Hide file list
(Ctrl+H)

Hides the File and Folder panes, along with menu and status
bar. Right-click on the Image pane provides a menu item
to redisplay these items.

Zoom

Zoom → Connected zoom Actions in this menu are identical to those in Zoom menu, but
apply to all images displayed in split view.

Zoom → Zoom in Increases the zoom by one increment, resulting in a larger im-
age.

Zoom → Zoom out Decreases the zoom by one increment, resulting in a smaller
image.

Zoom → Zoom to fit Automatically adjusts the zoom so that the image will fit with-
in the display pane. The effect on images with an original size
smaller than the display pane can be changed with the Allow en-
largement of image for zoom to fit option located on the Image
tab of the preferences dialog.

Zoom → Fit Horizontally Adjusts the zoom so image height fit within the display pane.

Zoom → Fit Vertically Adjusts the zoom so image width fit within the display pane.

Zoom → Zoom n:m (Z) Set zoom to the n:m value. 1:1 is the original size of the image.
When n is greater than m, zoom in occurs else zoom out occurs.

Zoom → Zoom n:m (Z) Split

Split → Horizontal Splits main image view in two horizontal panes.

Split → Vertical (U) Splits main image view in two vertical panes.

Split → Triple Splits main image view in three horizontal panes.

Split → Quad Splits main image view in four panes.

Split → Single (Y) Reverts to normal view mode (one image).

Image Overlay+Image Overlay Displays Image Overlay information box (OSD), use twice to
add histogram to it.

Image Overlay+Histogram chan-
nels

Switches channels displayed in the histogram (red, green, blue,
RGB, value, maximum value).

Image Overlay+Histogram log
mode

Toggles between linear and logarithmical histogram.

Full screen Toggles the full screen window display.

Over/Under Exposure (Shift+E) Toggles highlighting of pixels that are either over or under ex-
posed. This function operates on the displayed pixels. If a raw
file is being displayed, the embedded jpeg data is being used.
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If the image is zoomed, the zoom type affects the results. Two-
pass rendering also has some influence.

If a pixel has any channel at zero or full-scale, the pixel is dis-
played in red.

Keywords Toggles display of the Keywords sidebar.

Sort manager Toggles display of the Sort Manager sidebar.

Hide Bars and Files (`) This item is intended to be used by its shortcut key. When
pressed, the info sidebar, sort manager, file list, menu and sta-
tus bars will be hidden (if displayed). Pressing the shortcut key
again will revert the display to its previous layout.

Hide Selectable Bars (Control+`) This item is intended to be used by its shortcut key. When
pressed, bars selected in Preferences/General will be hidden.
Pressing shortcut key again will revert the display to its previ-
ous layout.

Toggle slideshow Begins or ends a slide show, the slide show status is displayed
in the status bar.

Pause slideshow Pauses a slide show, the slide show status is displayed in the
status bar.

Faster Decreases slide show interval in units of 0.5 seconds.

Slower Increases slide show interval in units of 0.5 seconds.

Refresh Updates the contents of the folder and file lists to match what
is currently on disk, the current image will also be reread from
disk.

Windows menu
This menu permits you to define several different window layouts that can be recalled at any time.

New window → default (Ctrl+N) Opens a new window with the default layout. The window is
given a name in the form "lw<n>".

New window → from current Opens a new window with the layout of the window that has
focus. The window is given a name in the form "lw<n>".

Rename window If a window is given a name that does not begin with the char-
acters "lw", the layout will be saved and be available for load-
ing at a later time..

Delete window Delete a saved window layout from the list.

Close window Close the window. If the window is the "main" window, close
all windows.

Help menu
Contents (F1) Opens the Geeqie user manual in a new browser window.

Search and Run Commands (/) Opens a text box in which you may type characters to find a
command. The characters you type will be matched to the first
characters of any word in all the commands in Geeqie - both
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built-in commands and plugins - and matching actions will be
displayed in a pop-up. You may scroll to any of the matching
commands and press Enter to execute the command. Press-
ing Enter without selecting from the list will execute the first
action in the list. Press Esc to close the box.

On-line help search Use a web browser to search Geeqie's on-line help files. The
search engine used is defined in Preferences General .

Keyboard shortcuts Displays a window listing the default keyboard shortcuts.

Keyboard Map Displays an image showing the currently allocated keyboard
shortcuts.

Release notes Displays a window containing the release notes for the version
of Geeqie in use.

About Opens a window containing the Geeqie version, credits, web-
site, and email contact information.

Log window Opens the log window, mostly used for debugging purposes.

Tear off menus
Menus can be permanently displayed by selecting the dotted line item at the top of each menu category.
A tear off menu will behave the same as an ordinary window. To close a tear off menu, select the
dotted line item at the top of the menu.

Keyboard shortcuts
The keyboard sequence associated to each menu entry is listed within the main window menu bar. For
reference, the complete list of default keyboard shortcuts can be found in section Keyboard Shortcuts .

Changing the main window menu bar keyboard short-
cuts

The section Keyboard Options describes how to modify the keyboard shortcuts used in the main menu.

Status Bar
The status bar contains information and details about the contents of the main window. Information
displayed includes the progress of generating thumbnails, the number of files in the file list with byte
size, the current file selection count including byte size, details about the currently displayed image,
and the zoom and image scroll settings. The current sort preference is also displayed, and can be
adjusted from the status bar.

The status bar is comprised of five sections, from left to right these are a progress bar, sort method,
file list counts, image details, and zoom and scroll setting. Each section is described below.

Progress Bar
The Progress bar updates to display the current state of thumbnail generation, or the reading of meta-
data in the current folder.
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When “Loading thumbs...” is displayed, thumbnails are currently being generated when Geeqie is idle;
the progress bar will update to display the percentage of thumbnails that are completed.

When “Loading meta...” is displayed, certain metadata is being loaded when Geeqie is idle; the
progress bar will update to display the percentage of files that have been read. Refer to Preferences
metadata.

Sort method
This is the method used to sort image names in the file list. Clicking or activating this field will display
a menu to allow selection of the sort method.

Name Images are sorted by file name.

Number Images are sorted by natural numerical order, such that, for ex-
ample, 9_name.jpg will be listed before 10_name.jpg.

Date Images are sorted by file modification date.

File Date Images are sorted by one of four types of file date. They are
described in the Reference section .

Size Images are sorted by file size on disk.

Rating Image are sorted by Xmp.xmp.Rating.

Class Image are sorted by class. The class types, and sort order, is:

• Unknown

• Image

• Raw Image

• Video

• Metadata

Ascending Toggles between increasing and decreasing sort order. A check
will appear next to this entry to indicate ascending sort order.

Note
When images have equal rank, for example in rating or class sorts, within each section images
will be sorted by filename.

File list
This section displays the count of files that appear in the file list, including the total byte size. The
number of files selected is displayed in parenthesis, including the total byte size of the selected files.
The slide show status is also displayed here; when a slide show is running, “Slideshow” will appear,
the text will change to “Paused” when a slide show is in the paused state.

Image Details
This section displays the dimensions (width x height) and file byte size of the image that is active in
the image pane. When the format of the file in the image pane can not be determined the dimensions
will show as “(0 x 0)”, in addition “(no read permission)” may appear if the file permissions do not
allow reading the contents of the file.
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Zoom and Scroll
The button label displays the current zoom ratio. A ratio of 1:1 is the image's original size. When the
left number is larger the image is displayed larger than original size, when the right number is larger
the image is displayed smaller.

A tilde (~) appears within the ratio display when the zoom is set to fit the image within the display
area. In this zoom mode the ratio is automatically adjusted, and the displayed ratio may not be the
actual ratio because the status bar display rounds the actual value to the nearest tenth (0.1).

Clicking this button permits control of the behavior of the zoom and scroll settings used when changing
the displayed image.

Zoom to original size The new image is set to its original size.

Fit image to window The new image's zoom is changed so that the image will fit
within the current view area.

Leave zoom at previous setting The zoom setting is unchanged, the new image will be scaled
the same as the previous image.

Scroll to top left corner The new image is displayed from top left corner.

Scroll to image center The new image is centered

Keep the region from previous im-
age

The new image is positioned as the previous one, whenever
possible.

Buttons
The Status bar toolbar buttons, the defaults are shown below, correspond to selected menu action. The
buttons displayed may be changed in the Toolbar tab of Preferences.

Exif rotate

 Toggles the auto-rotation of images if they have Exif orientation data. Refer also to the FAQ .

Show Pixel Info

 Shows coordinates and RGB[A] value under cursor.

Enable Color Management

 Enables color profiles.

Save Metadata

 Opens dialog for review and saving of metadata changes.
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Layout
The main window consists of four areas, the folder pane , file pane , image pane , and the status bar
. The status bar is always at the bottom of the window. The three remaining areas, or panes, can be
arranged and sized by the user.

Selecting the location of each pane
The arrangement of the folder, file, and image pane is selected on the Window Layout dialogue.

Changing the size of a pane
Between the panes of the main window are two dividers that can be moved with the mouse to adjust
the size of each pane. Press and hold the primary button, then move the divider to the desired location
and release the button.

Folder pane

The folder pane contains the menu bar, tool bar, path entry, and folder list. The list can be set to display
the sub folders of the active folder or a tree that starts with the root folder and contains all folders
in the file system.

File pane

The file pane lists the images contained in the active folder. The file pane can be set to display as a
vertical list or an icon view.

Image pane

The image pane is where the active image is displayed.

23



Chapter 3. Sidebars
A sidebar is a panel that appears next to an Image Pane , and displays additional information about
the image.

Info Sidebar
The Info Sidebar shows various information about the image and can also be used for metadata editing.

To toggle display of the Sort Manager select View → Info Sidebar (Ctrl+K) .

It consists of several panes. Left-clicking on the pane title expands or collapses the pane. Right-clicking
on the pane title or on empty space opens a context menu allowing you to add and remove panes, or
move them up and down.

Histogram
This histogram is identical to that shown in the Image Overlay . It can be configured by right-click to
modify the display of color or linear/logarithmic scale.

Title
>

Note

Title text is stored in the Xmp.dc.title tag.

Comment

Note

Comment text is stored in the Xmp.dc.description tag.

Keywords
Keywords, together with a flexible search tool, are essential for handling large image collections.

Geeqie has free-form keywords and a hierarchical method of adding new keywords to an image.

Note

Keywords are stored in the Xmp.dc.subject tag.

Note

Keywords are not case-sensitive unless selected as so in Preferences

The Keyword pane in the sidebar consists of two sections:

• The left hand section which is for free-form keywords
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• The right hand section which is a hierarchical structure, allowing sets of keywords to be added.

The contents of the left-hand box is the data written to file.

The right-hand section has two types of entries :

• Keywords
• Helpers

An example of keyword hierarchy is:

        [ ] animal
        [ ]   mammal
        [ ]     dog
        [ ]     cat
        [ ]   insect
        [ ]     fly
        [ ]     dragonfly
        daytime
        [ ]   morning
        [ ]   afternoon
      

In this example daytime is a Helper, and all the others are keywords. Helpers are not stored in metadata
- their purpose is only as an organisational aide.

In the above example if cat is clicked, both mammal and animal will also automatically be checked,
and all three transferred to the left hand box, ready for writing as metadata.

If a hierarchy of keywords are checked, and the top-level item then un-checked, all lower level key-
words will also be unchecked and will be removed from the left-hand pane.

Warning

This action cannot be undone.

Irrespective of their position in a hierarchy in the right-hand box, all keywords are written as individual
entries into metadata. When metadata for an image is read in, Geeqie will attempt to recreate any
hierarchies within the data, and display it accordingly in the right-hand box.

Right-click on the left-hand box allows the selected keywords to be written to the currently selected
files - the keywords may be either added to the existing contents, or entirely replace the existing
content.

Warning

Keyword completion is used when selecting keywords. If the selected area includes part of
a keyword, the selection will automatically be expanded to cover the whole keyword. If no
text is selected, all keywords will be used.

Right-click on the right-hand box allows a connection to be made between a keyword and a mark. The
Marking Images section shows how marks and keywords inter-operate.

The ordering of keywords in the right-hand box may be changed by drag-and-drop.

The meta-data write operation for a file is triggered either manually or as defined in Metadata .

If the right-click menu item Revert is executed at any time after a Show all or Collapse all , the keyword
layout will be restored to the state prior to the Show all or Collapse all .
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If the right-click menu item Revert is executed at any time before a Show all or Collapse all , the
keyword layout will be restored to the state existing at start-up.

Note

The selections in the sub-menu On any change will affect the operation of the Revert option.

Keyword Autocompletion
The text box at the bottom of the keywords pane is used for autocompletion. Any keywords typed
into the standard keyword box or the autocompletion box will be remembered as candidates for future
autocompletion.

Frequently used sets of keywords can be entered as comma-delimited lists.

The list of keywords used for autocompletion can be edited on the Keywords tab of the Preferences
dialog.

The menu action "Keyword autocomplete", set to Alt + K by default, will shift the keyboard focus
to the autocomplete box. Pressing Alt + K a second time will shift the keyboard focus back to the
previous object.

List panes
There are five list panes, whose contents can be configured to display Exif, XMP or IPTC metadata
tags. The five panes are:

• Title

• Exif

• File Info

• Location and GPS

• Copyright

Any metadata tag can be displayed in any pane - the pane titles merely exist as an organisational aide.

It is possible to reorganise the data displayed by drag-and-dropping any item within a pane, or from
one pane to another (although in some cases it makes little sense to do so).

Note
It is not possible to undo these actions, nor is there a way to reset the display to its original
settings.

It is also possible to drag new items from the Exif Window onto any pane.

As an aide, in addition to standard metadata tags, Geeqie can call lua scripts and also provides certain
pre-formatted tags. These tags are:

Table 3.1. Pre-formatted tags

Tag Replaced by Meta data

formatted.Camera Camera and software name

formatted.DateTime Image Date
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formatted.ShutterSpeed Shutter speed in seconds (e.g. 1/60s)

formatted.Aperture Aperture (e.g. f5.6)

formatted.ExposureBias Exposure bias (e.g. +0.3)

formatted.ISOSpeedRating ISO sensitivity (e.g. 100)

formatted.FocalLength Focal length

formatted.FocalLength35mmFilm Focal length 35mm

formatted.SubjectDistance Subject distance

formatted.Flash Flash

formatted.Resolution Resolution

formatted.ColorProfile Color profile

formatted.GPSAltitude Altitude above sea level

formatted.GPSPosition Latitude, Longitude

formatted.localtime Local time corrected for UTC offset, DST correc-
tion a

formatted.timezone Timezone indicated by GPS lat/long values b

formatted.countryname ISO 3166 country name indicated by GPS lat/long
values

formatted.countrycode ISO 3166 two-letter abbreviated country name in-
dicated by GPS lat/long values

file.size file size in bytes

file.date file date and time in human readable form

file.mode file mode flags

file.ctime refer to operating system documentation for the
meaning of ctime

file.owner the file's owner. Refer to operating system docu-
mentation for the meaning of file permissions

file.group the file's group. Refer to operating system docu-
mentation for the meaning of file permissions

file.class the file's class e.g. Image, RAW image etc.

file.link if the file is a symbolic link, shows the path of the
source file

file.page_no if the file is a multi-page file, e.g. .tiff, the cur-
rent page number and page total is displayed (e.g.
[2/10])

lua.lensID lens identification data c

lua.<lua script> Call a lua script d

a Refer to UTC and DST section.
b Refer to UTC and DST section.
c Requires lua and exiftool.

Note
This function may be slow.

dThe output is expected to be text.

Right-clicking on an item opens the context menu:

Add entry Key Exif, IPTC, XMP or
Geeqie formatted exif
tags.
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Title Displayed title text.

Show only if set Inhibit display if the tag
is empty.

Editable Displays the value as
editable.

Note

Geeqie in-
ternally con-
verts Exif and
IPTC metada-
ta to XMP on
read and back
on write, thus
any changes
made to Exif
and IPTC
here will be
lost on write.
You must ed-
it the corre-
sponding
XMP instead.

An exception
is Makernote
tags which
don't have an
equivalent in
XMP. Howev-
er Makernotes
cannot be writ-
ten to an exter-
nal file (a side-
car or Geeqie
metadata file).

Show hidden Shows all entries regardless of Show only if set .

Map Display
Geeqie can display maps created by the openstreetmap.org [https://www.openstreetmap.org] . To use
this facility, Geeqie must have been compiled with the --enable-map option.

• Image location display

All geocoded images in the currently displayed folder will show as small icons on the map. Clicking
the icon will expand the icon to show an image thumbnail, plus other pre-defined image data.

Right-click on the map will show other map options.

Middle-click controls the map-centering function.
• Geo-coded search
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Left-click stores the latitude/longitude under the cursor into the clipboard. This may be used to
define the origin of a geocode search .

• Geo-coding Images

If an image is not geocoded, the filename or icon on the file pane can be dragged-and-dropped onto
the map. The image latitude and longitude xmp meta-data will be updated to the drop position on
the map.

• Map Centering

If an internet URL containing a valid latitude and longitude is dropped on the map, the map will
be re-centered on that location. The zoom level will not change. Refer to Decoding Latitude and
Longitude .

Sort Manager Sidebar
The Sort Manager sidebar provides a convenient method to quickly sort many files into a set of folders
or collections.

To toggle display of the Sort Manager select View → Sort Manager (Shift+S) .

The mode of the Sort Manager is selected by the drop down list under the sidebar title. The Folder
mode allows moving or copying the visible image to a folder, and the Collection mode allows adding
the visible image or file selection to a collection.

Folder view
The Sort Manager folder view consists of a vertical list for bookmarking folders, a section to select
the operation to perform, and a set of buttons along the bottom.

Clicking or activating an item in the list will copy, move, or link the active image's file to that location.
The active image will then change to the next image.

Bookmark list

This is a list of possible folders to use as a destination for the selected operation. A context menu will
appear by right clicking on an item, or pressing the menu key when the item has the focus.

Folders can be added to the list by activating the Add button at the bottom of the sidebar, or dragging
a folder onto the list.

To edit an item select Properties from its context menu. A dialog will appear allowing the Name,
Path, and Icon for the item to be changed. Select OK to close the dialog and apply the changes, or
Cancel to close the dialog and discard the changes.

To change the order of the list, select Move up or Move down from the item's context menu. To
move an item with the keyboard move the focus to that item, then press Shift+Up or Shift+Down
to move the item.

To remove an item from the list select Remove from it's context menu.

Copy, Move, Link and Desktop actions

Copy, Move and Symbolic Link are available operations to use on the active image; they should be
self explanatory. In some cases, Desktop files are also listed. This is detailed in Plugins Configuration
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Add button

Activate this button to add a folder to the bookmark list. A dialog will appear to allow selection of
the folder to use for the new item.

Undo button

Activate this button to undo the last copy, move, or link operation. The undo function can only reverse
the most recent operation.

Collection view
The Sort Manager collection view consists of a vertical list of collection, a section to determine the
current selection, and a set of buttons along the bottom.

Clicking or activating an item in the list will add the selected image to that collection.

Collection list

This is the list of collections located in the folder listed in Configuration Files . Activating a member
of this list will result in the current image selection to be added to the collection. If the image already
exists within the collection, it will not be added a second time.

A new empty collection can be added to the list by activating the Add button at the bottom of the
sidebar.

Choosing the selection style

The images to add when activating a collection is determined by the selection style:

Add image The visible image is added to the collection.

Add selection All images selected in the file list will be added to the collec-
tion.

Add button

Activate this button to add a new empty collection to the visible list. A dialog will appear to allow
entry of the name to use for the new collection.

Undo button

Activate this button to undo the last add operation. The undo function can only reverse the most recent
operation.
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This section describes the windows that may be displayed simultaneously with the Geeqie main win-
dow. They are initiated via the View and File menus.

Image Window
An image window is a window that displays only the image, without menus or sidebars.

An image window can always be opened from the context menu of all images and files. Keyboard
shortcuts exist for most windows that display images or files, however the shortcut can vary dependent
on the type of window containing them.

The image pane contained in an image window behaves and operates similar to the Image Pane of a
Main Window, including the Image Overlay . The keyboard shortcuts are the same, and the context
menu is the same except Hide file list is replaced by Close window . The slide show and full screen
functions are also available.

Navigation
When the image window is initiated from an image selection or from a collection window, the dis-
played image can be changed forward or backward in the list with the respective PageDown and
PageUp keys. In addition, all navigation methods for the mouse and keyboard are similar to that of
the Image Pane of a Main Window.

Drag and Drop
Images can be dragged and dropped onto an image window, but the process is somewhat different to
that of an Image Pane . If multiple images, a folder or an image from a collection window is dropped
onto the image window, you can cycle through all these images using the navigation keys.

The dropped item can be one or more files, folders, or an image from a collection window:

One or more files The image window will display the first image; the list of
dropped images can be navigated similar to a main window's
image pane.

One or more folders When the dropped list of items includes a folder, a menu will
appear allowing to skip the folders, add their contents, or add
their contents recursively. After choosing from the menu the
requested files will be added to the image window.

Image from a collection The image window will change to display the image and be-
come linked to the collection containing the image. Images in
the collection can then be navigated and viewed from the im-
age window.

Changing the image window by dropping a new item onto it will cause the previous list of images or
linked collection to be discarded.

To update the image display in the event that the source file has changed, press R .

Exif Window
The Exif window shows the Exif, IPTC and XMP metadata that are present in the image file.
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Unlike the other parts of the program, this window shows the "raw" metadata read from the file,
without any post-processing. Thus, this window is ideal for metadata debugging.

The Exif pane in the Info Sidebar is more suitable for general use, as it displays merged data from
sidecar and private metadata files.

To facilitate including extra items in the Exif pane in the Info Sidebar , it is possible to drag-and-drop
an item from the Exif window onto the Sidebar pane.

A search of the Exif data can be initiated by clicking anywhere on the column you wish to search, and
then type Ctrl + F or press any alpha-numeric key. The search is case-insensitive

Pan View
This window offers alternative views of the current directory and its children .

It may be opened by View → Pan view (Ctrl+J) . You can pan the view as you pan an image in normal
view mode, using left mouse button and drag.

A primary mouse button click on any image will display information about the image. Secondary
mouse button will show a context menu.

The Keyboard and Mouse Shortcuts available are listed in the Reference section.

Note

Pan view recursively visits each folder under the specified folder. This can consume consid-
erable computer resources.

Select a folder
Location The initial location is the current Geeqie folder when the Pan

view window is opened.

Choose a view mode
A select box let you choose among different view modes:

Timeline Shows images grouped by date.

Calendar Shows a calendar with the number of images indicated for each
day (as dots and number). Left mouse button click will show
images in a pop-up.

Folders Show images grouped by folder. Each box represents a folder.
Parent and children folders are shown as boxes enclosing other
boxes.

Folders (flower) Show images grouped by folder. Each box represents a folder.
Parent folders are linked to children by a line. The top folder
is the center of the flower.

Grid All images are shown on a grid.
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How each image should be represented
Another select box let you choose the representation of each image:

Dots Each image is represented by a dot.

No images Each image is represented by a square box.

Small thumbnails Each image is represented by a small thumbnail.

Normal thumbnails Each image is represented by a normal thumbnail.

Large thumbnails Each image is represented by a large thumbnail.

1:10 (10%) Each image is represented by reduced image (1/10 of the orig-
inal's dimensions).

1:4 (25%) Each image is represented by reduced image (1/4 of the origi-
nal's dimensions).

1:3 (33%) Each image is represented by reduced image (1/3 of the origi-
nal's dimensions).

1:2 (50%) Each image is represented by reduced image (1/2 of the origi-
nal's dimensions).

1:1 (100%) The original image is shown at its normal dimensions.

Find
At the bottom of the window:

Find button Shows a text field for image search. One can enter either:

• filename or part filename

• file date in any of the following forms, where the separator
may one of /-,. or a space:

• yyyy-mm-dd

• yyyy-mm

• yyyy

Enter will start the search, pressing it again will move to the
next match. The matched file is made visible and details are
shown for it.

Collections
Geeqie provides the ability to build lists of images, regardless of the location of the files on disk.

A collection window displays the contents of a collection. It allows the collection to be modified and
access to the images contained in the collection.

To open a new empty collection window select File → New collection (C) .

To open an existing collection, select File → Open collection (O) . A dialog will appear requesting
the location of the collection file. A window will the open containing the selected collection. Recently
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opened or saved collections can also be opened by selecting the collection's file name from the Open
recent sub menu of the file menu.

To delete or rename a collection, select File → Open collection (O) , right-click on the collection you
wish to delete or rename, and then select Delete or Rename .

The collection window consists of a pane to display the contents of the collection, and a status bar
along the bottom of the window.

Icon pane
The icon pane displays images contained in the collection as thumbnails in a grid, by default the file
names also appear below each thumbnail.

The Icon pane works exactly like the Icon view mode of the File Pane in a main window, but with the
addition that the contents of the collection can be organized with drag and drop.

A context menu is available for the icon pane by right clicking the mouse or pressing the Menu key.

Keyboard and Mouse Shortcuts are available in the collection window:

The selection can be changed using the keyboard and mouse the same as in a File Pane of the main
window.

Status bar
The status bar displays the total number of images in the collection, and the number of selected images
in parenthesis. A progress bar also displays whenever thumbnails are loading from disk.

Drag and Drop
Drag and drop can be initialized with the primary or middle mouse buttons. Dragging an image that
is selected will include all selected images in the drag. Dragging an image that is not selected will
drag only that image.

Dropping files and folders onto the collection window will add them to the collection, they will be
inserted at the location of the drop. A red arrow will indicate the location of the drop as files are
dragged over the collection window. When one or more folders are included in the drop list, a menu
will appear to select how to handle the contents of the folders.

To move images within the collection to change their order, initiate a drag for the selected image(s)
and then move the mouse to the desired location within the window. A red arrow will appear to assist
in determining the destination of the dragged images. Release the drag to move the images to the new
location in the list.

Note

When renaming or moving files within Geeqie, the contents of collections located in the
collections folder will automatically update to the new name or location.

Append Images
Right-click menu items permit images to be appended from either another collection or from the cur-
rently selected folder.
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Randomized Sort
Right-click menu item Sort , in addition to the standard sort methods, permits images to be randomly
arranged.
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Chapter 5. Search and Select
Geeqie provides comprehensive set of search methods, including not only the standard functions such
as file date or size, but also image similarity.

There is a duplicate file finder, which uses search parameters such as image dimensions or checksum.
Two sets of image files may be compared.

Geeqie also has a set of temporary "marks" or "tags" which may be allocated to any image as an aide
to file organising.

Caching Data For Searches
Searching large numbers of files for similarity can take significant cpu time. Part of this is the time
to compute the similarity matrix for each file.

If the Cache Thumbnails option is selected in Preferences/General, the similarity matrix, checksum,
image size and Exif Date may also be cached. This will reduce the time needed for future searches.

Note
If you frequently search on similarity and your images are in a tree arrangement under a single
point, the Create file similarity cache from the top of the tree will generate the similarity data
for all images.

Similarity data are stored in a folder hierarchy that mirrors the location of the source images. The data
have the same name as the original appended by the file extension .sim.

The root of the hierarchy is:

$XDG_CACHE_HOME/geeqie/thumbnails/

or, if $XDG_CACHE_HOME is not defined:

$HOME/.cache/geeqie/thumbnails/

Search Window
Geeqie provides a utility to find one or more images based on various parameters.

To display a new Search Window press F3 or select Search from the File menu.

To start a search activate the   Find  button or press Ctrl + Enter . A search in progress

can be stopped by activating the   Stop  button or press Ctrl + Enter .

The progress of an active search is displayed as a progress bar at the bottom of the window. The
progress bar will also display the total files that match the search parameters, and the total number
of files searched.

When a search is completed, the total number of files found and their total size will be displayed in
the status bar.
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Search location
One of several locations can be chosen as the source to use in the search.

Path The search will include files located in the selected folder, en-
able the Recurse check box to include the contents of all sub
folders.

Comments This option is only for use with GqView legacy metadata.

The search will include all files that have a keyword or com-
ment associated to it.

Note
Only keyword and comment associations stored in the
user's home folder are included in this search type.

Results The search will include all files currently listed in the results
list. Use this to refine a previous search.

Collection The search will include all files in the selected collection.

Search parameters
Each search parameter can be enabled or disabled with the check box to its left. For a file to be a
match, all enabled parameters must be true.

File If "name is" is selected, the search will match if the text exactly
matches the file name. If "name contains" or "path contains" is
selected, the search will match if the entered text appears within
the file name or path.

The text comparison can be made to be case sensitive by en-
abling the Match case checkbox.

The search can be restricted to symbolic links by enabling the
Symbolic Link checkbox.

If "contains" or "path contains" is selected, Perl Compatible
Regular Expressions are used.

File size The search will match if the file size on disk is equal to, less
than, greater than, or between the entered value, depending on
the method selected from the drop down menu. The between
test is inclusive - for example a file of size 10 will match if the
size parameters are between 10 and 15.

File date The search will match if the file date is equal to, before, after,
or between the entered date, depending on the method selected
from the drop down menu. The between test is inclusive, for
example a file with date of 10/04/2003 will match if the date
parameters are between 10/04/2003 and 12/31/2003.

For convenience, the    button displays a pop up calendar
to enter the date.
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One of four date types may be selected. They are described in
the Reference section .

Note
If an image does not have an exif date, it will default
to 01 January 1970.

Image dimensions The search will match if the image dimensions are equal to, less
than, greater than, or between the entered values, depending on
the method selected from the drop down menu. The between
test is inclusive.

The image dimensions test is simple, both width and height
must be within the allowed values for a match.

Image content The search will match if the image contents are similar with-
in the percentage value, inclusive. This uses the same test and
data that is used to determine image similarity when Finding
Duplicates . The entry is for entering the path for the image to
use in this test.

Keywords The search will match if the file's associated keywords match
all, match any, or exclude the entered keywords, depending on
the method selected from the drop down menu. Keywords can
be separated with a space, comma, or tab character.

Comment The search will match if the file's Comments field contains the
entered pattern. Perl Compatible Regular Expressions are used.

Exif The search will match if the file's Exif Tag contains the pattern
entered in the Value box. Perl Compatible Regular Expressions
are used.

Note
The value checked will be against the formatted val-
ue e.g. for focal length search for 67.5 mm and not
675/10. See also pre-formatted tags

Geocoded position The search will match if the file's GPS position is less than or
greater than the selected distance from the specified position,
or is not geocoded, depending on the method selected from the
drop down menu. The search location can be specified by

• Type in a latitude/longitude in the format 89.123
179.123

• Drag-and-drop a geocoded image onto the search box

• If Geeqie's map is displayed, a left-click on the map will store
the latitude/longitude under the mouse cursor into the clip-
board. It can then be pasted into the search box.

• Copy-and-paste (in some circumstances drag-and-drop) the
result of an Internet search.

Note
In this last case, the result of a search may contain
the latitude/longitude embedded in the URL. This may
be automatically decoded with the help of an external
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file:- $HOME/.config/geeqie/geocode-pa-
rameters.awk See Decoding Latitude and Longi-
tude for details on how to create this file.

Class The search will match if the file's class is, or is not, one of the
following types.

• Unknown

• Image

• Raw Image

• Video

• Document

• Metadata

• Unknown

• Broken (Of class Image, Raw Image, Video, or Document,
but Geeqie cannot display an image)

Marks The search will match if the file does or does not have a mark
attached to it. Refer to Marking Images .

Results list
Files that match the parameters of the search are shown in the list. By default they are displayed in
the order that they are found. To sort the results list by a column, activate or click the column title.
Activating a column that is already used to sort the list will toggle between increasing and decreasing
sort order.

A context menu is available for the result list by right clicking the mouse or pressing the Menu key
when a row has the focus.

The Keyboard and Mouse Shortcuts available are listed here.

The image Dimensions column of the result list will only contain dimension information when dimen-
sions are included in the search parameters.

Status bar
At the bottom of the search window is an area that includes the following items from left to right:

Thumbnails Enable this check box to display a thumbnail next to each image
in the results list.

File count display Displays the total count of files in the results list, and their size
on disk. The count of selected files will appear in parenthesis.

Search progress When a search is active, the text “Searching...” will appear here.
Two numbers in parenthesis will also be displayed, the first
number is the number of files that match the search parameters
and the second number is the total number of files that were
searched.
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Find

Activate the find button to start a search with the selected pa-
rameters.

Stop

Activate the stop button to end a search that is in progress.

Drag and Drop
Drag and drop can be initiated with the primary or middle mouse buttons. Dragging a file that is
selected will include all selected files in the drag. Dragging a file that is not selected will first change
the selection to the dragged file, and clear the previous selection.

Finding Duplicates
Geeqie provides a utility to find images that have similar attributes or content.

To display a new Find Duplicates Window select File → Find duplicates .

Adding files to be compared
Add files to be compared using drag and drop. Drop files or folders onto the Find Duplicates window
to add them to the list of files to compare. When one or more folders are dropped onto the window a
menu will appear allowing you to choose the desired action:

Add contents The contents of dropped folders will added to the window.

Add contents recursive The contents of dropped folders and all sub folders will be
added to the window.

Skip folders Ignore folders contained in the drop list.

When files are added to the window, the comparison is restarted
to include the new files.

Note

Symbolic links to folders will be followed, but symbolic links to files will be ignored. Only
actual files will be tested.

Comparison methods
The attribute to use for two images to match can be selected with the Compare by: drop down menu.
Each method is explained below:

Name The file name.

Name case-insensitive The file name but ignoring case.

Size The file size.

Date The file date.

Dimensions The image dimensions.
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Checksum The MD5 file checksum.

Path The complete path to file.

Similarity (high) Very similar image content. Preset to 95%.

Similarity Similar image content. Preset to 90%.

Similarity (low) Slightly similar image content. Preset to 85%.

Similarity (custom) The percentage value to used to consider two images a match is
configured in the spin box at the bottom of the window. Setting
a value to less than 85 is not likely to be useful.

Name ≠ Content Show images with the same name but different content.

Note

Because pairs of files are being compared, when there
are multiple hits care should be taken when analyzing
the results.

Name case-insensitive ≠ Content Show images with the same name, ignoring case, but different
content.

Note

Because pairs of files are being compared, when there
are multiple hits care should be taken when analyzing
the results.

Show all Do not compare. Show all images.

Results list
Files that match with the selected comparison method will appear in the list. Matching files are grouped
in alternating color.

The order of the result list can be changed by clicking on the column header. This will re-order the
images within each set. When comparing by image content similarity, the matching sets will be sorted
by order of rank starting with the files that are most similar.

A context menu is available for the result list by right clicking the mouse or pressing the Menu key
when a row has the focus.

Groups in the results list may be selected by using the keyboard. Refer to the Find Duplicates Window
section of Keyboard Shortcuts .

The selection can be changed using the keyboard and mouse the same as in a file pane of the main
window.

The image Dimensions column of the result list will only contain dimension information when com-
paring by dimensions, or when the data is easily available from memory or has been read from the
cache.

Status bar
Along the bottom of the Find Duplicates window is an area that displays the count of files contained
in the window, and the number of files in the result list.
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The status bar will also display the status of an active compare operation using the progress bar. A
compare operation involves 2 or 3 stages, depending on the type of comparison. These are the stages
in order:

1. If necessary, extra data is read into memory for the comparison stage and the progress bar will
indicate this stage with text such as “Reading dimensions...”, “Reading checksums...”, or “Reading
similarity data...”.

2. The images are compared using the selected method, the progress bar will indicate this stage with
the text “Comparing...”.

3. The results are sorted for display, the progress bar will indicate this stage with the text “Sorting...”.

Stage 1 is only used for the Dimensions, Checksum, and Similarity compare methods.

If the time to complete a stage will be significant, an estimated time to completion will also be
displayed in the progress bar. The estimated time only refers to the current stage, other stages are not
included in the estimate. The time estimate is displayed using the format MINUTES:SECONDS.

Thumbnails
Thumbnails can be displayed beside each image in the result list by enabling the Thumbnails check
box.

Ignore Orientation
When selected and a similarity compare is being used, the images are checked against 4 rotations: 0°,
90°, 180°, 270°, plus flip and mirror.

Sort
The normal sort order is for groups (in the case of Similarity checks) with the highest number of
near-100% matches to be at the top of the list.

If this box is checked, groups with the lowest number of matches are placed at the top of the list.

Compare two file sets
Sometimes it is useful to compare one group of files to another, different group of files. Enable this
check box to compare two groups of files. When enabled, a second list will appear and files can be
added to this list using the same methods for the main list.

When comparing two file sets the results list will display matches between the two lists. For each
match group, the first file is always from the main group, and the remaining files are always from
the second group.

Drag and Drop
Drag and drop can be initiated with the primary or middle mouse buttons. Dragging a file that is
selected will include all selected files in the drag. Dragging a file that is not selected will first change
the selection to the dragged file, and clear the previous selection.

Image Data Window
Ctrl+Shift+Right Mouse click : Use this to display a dialog containing the data stored for
the clicked image file. This is usually only useful for debugging purposes.
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Marking Images
Marks are intended as a temporary method of grouping and filtering sets of images.

Keywords are intended as a permanent method of identifying sets of images, and to this end it is
possible to link any mark with any keyword.

The Select menu gives access to the marks operations of setting, filtering and intersection.

There are 10 individual marks, any of which can be associated with an image simply by pressing the
0 to 9 keys on the keyboard, where key 0 represents mark 10.

If the Show Marks menu has been selected, each image will have a set of 10 check-boxes displayed
adjacent to it in the file pane in both icon and list mode. In addition a set of 10 check-boxes will be
shown at the top of the files pane. Clicking any of these will filter the displayed list.

Moving the mouse over any of the check-boxes at the top of the files pane will show mnemonic text
for that mark. The text can be modified by right-clicking on the check box.

If the Image Overlay is being displayed, the currently set marks for the image are shown. It is not
necessary to include an entry into the overlay template for this to happen.

A keyword can be associated with a single mark by right-clicking on the keyword in the sidebar panel.
When a meta-data write operation for a file is triggered either manually or as defined in Metadata ,
the keyword data indicated by the current set of mark-to-keyword links will be written.

The associations between keywords and marks is preserved when Geeqie is shut down. The current
setting of marks can also be optionally saved - the setting is in the Behavior tab of Preferences .
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Chapter 6. Plugins
Geeqie provides the facility to execute external commands - any external command may be called
via this facility.

Actions may be performed on a single file, or on a set of selected files.

Plugins can do anything from running simple operations like symlink to activating fully featured pro-
grams like Gimp. Nor does the action have to be performed on files - you may, for instance, configure
a plugin to download images from your digital camera.

To perform these actions, Geeqie uses standard desktop files.

It is not necessary to understand the details of desktop file specifications because the Plugins Con-
figuration dialogue presents you with an easy-to-use template. This dialogue is accessed via Edit →
Configure Plugins .

Plugins will appear in the menu Plugins , unless specified otherwise in the desktop file.

Commands that are set to display their output in a window will show a dialogue when the command
is executed.

The Result dialogue will display the command's text output. If the plugin command will result in
multiple runs of the same command for each file, you can use the Stop button to stop Geeqie from
executing the command for remaining files.

Once all commands have completed, or if the Stop button was pressed and the pending command has
completed, you can use the Close button, or press Escape , to close the Result dialogue. The Result
dialogue can not be closed while a command is still running.

The supplied standard plugins are described in the Reference section.
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Chapter 7. File Management
Geeqie includes a set of utilities to copy, move, rename, and delete images. Cache maintenance utilities
are also provided.

Note
The standard commands for copy, move, rename, delete and create folder can be overridden
by Special Plugins

Copy and Move
To copy a file in Geeqie select File → Copy (Ctrl+C) and to move a file select File → Move (Ctrl+M) .
These operations also appear in the context menu of all images and files.

The Copy and Move operations and dialogs behave the same in Geeqie, with the only difference being
the final result. The remaining text of this page applies equally to the Copy and Move operations, for
the remainder of this page these will be referred to as a Copy/Move operation.

Initiating a Copy/Move operation will display a dialog to select the destination folder to Copy/Move
the selected file, after the destination folder is selected Geeqie will proceed to Copy/Move the images
to the destination. If an error occurs or a file exists with the same name as one of the files being Copy/
Moved, a dialog will appear prompting how to handle the situation.

The Copy/Move dialog
This is the dialog that is displayed when initiating a Copy/Move operation. The dialog contains a row
of buttons near the top, vertical list of bookmarks along the left side, a vertical list of folders in the
current path, a text entry field, and a row of buttons along the bottom.

Home button Activate this button to change the active path to your home
folder.

New Folder button Activate this to create a new empty folder as a sub folder of the
active path. The new folder will appear in the folder list ready
for you to type in the desired name.

Show Hidden check box Enabling this check box will cause hidden folders to appear in
the folder list.

Bookmark list This list on the left side of the window allows you to save links
to folders that are frequently used. Activating a bookmark will
change the active path to that pointed to by the link. To add
items to the bookmark list highlight a folder and press Ctrl+B ,
select “Add bookmark” from the folder's context menu, or drag
a folder onto the bookmark list.

The bookmark has a context menu that can be displayed by
clicking the right mouse button, or pressing the Menu key when
a bookmark has the focus. From the context menu you can edit
a bookmark, move it up or down in the list, or remove the book-
mark from the list. A bookmark can also be moved by pressing
Shift + Up or Shift + Down while it has the focus.

A bookmark with the name "." is treated as a special case. Each
time this bookmark is displayed, its path is loaded with Geeqie's
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current working folder. This bookmark, like any other, can be
deleted and re-created at any time.

Folder list This is the list that displays the folders contained in the active
path. To change the active path to a folder displayed in this list
double click the primary mouse button or highlight the folder
with the keyboard and press Enter or Spacebar . This list has a
context menu that allows renaming or bookmarking the select-
ed folder. A folder can also be dragged onto the bookmark list
to add a bookmark.

Path entry This text entry displays the active path of the dialog. The path
can be directly edited using this entry. Tab completion is sup-
ported, and the drop down arrow will display a list of recently
selected folders.

Copy/Move button The name of this button will differ depending on the selected
operation, activating it will start the operation with the folder
displayed in the path entry as the destination.

Cancel button Activate this button to close the dialog, the operation will be
aborted.

The error dialog
If a problem occurs because Geeqie is unable to Copy or Move a selected file a dialog will appear to
notify the user. The dialog will also ask if the operation should continue if one or more files remain
to be Copied or Moved.

The overwrite dialog
If a file with the same name exists in the selected destination a dialog will appear to notify the user
and ask how to resolve the conflict. The dialog will also display the source and destination images.
The following possible solutions will be offered:

Auto rename Enabling this check box to have Geeqie select a unique name
for the destination file, the proposed new name will appear in
the rename entry field.

Rename Enable this check box to manually enter a new name for the file.

Overwrite Activate this will overwrite the existing file, or rename it if one
of the rename check boxes are enabled.

Overwrite all Activating this will perform the same operation as the Yes but-
ton, however any further file name conflicts will be handled
quietly in the same method as is selected for the current file.

Skip This button will skip doing anything to the file in question, and
resume the operation with the next file. The source file will
remain untouched.

Skip All This will perform the same as the Skip button, however any fur-
ther file name conflicts will be quietly ignored for all remain-
ing files.

Cancel This will close the dialog and stop the operation, all remaining
files will be ignored.
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Rename
To rename a file in Geeqie select File → Rename (Ctrl+R) . Rename is also available in the context
menu of all images and files.

When renaming a file, a dialog will display allowing entry of the new name for the file. The dialog
will be different depending on the number of files selected to be renamed. A simple dialog will appear
when renaming a single file, however when renaming multiple files the dialog will include a list of
the file to be renamed and additional options.

Rename single file dialog
The dialog that appears when renaming a single file includes an image of the file, an entry to type the
new name of the file, a Rename button, and a Cancel button. Type the new name into the text entry
and press Enter or activate the Rename button to rename the file. Press Escape or activate the Cancel
button to close the dialog and abort renaming the file.

When renaming a file and the new name already exists on the file system a dialog will appear showing
the renamed and existing files. To overwrite the existing file press Enter or activate the Overwrite
button. Press Escape or activate the Cancel button to close the dialog abort renaming the file.

Rename multiple files dialog
The dialog that appears when renaming multiple files includes the list of files to be renamed, a preview
image of the active file, an entry to enter the new file name, an auto rename check box, a Rename
button, and a Cancel button.

Manually enter new file names To manually enter the new name of each file, the active file
will be displayed in the image preview and it's original name
will be displayed above the text entry. To rename the file type
the new name and press Enter or activate the Rename button.
When a file is successfully renamed it will be removed from
the list and the next one will become the active file. After all
files have been renamed, the dialog will close.

Files do not have to be renamed in the order that they appear
in the list, highlighting a name in the list will make it become
the active file.

When renaming a file and the new name already exists on the
file system a dialog will appear showing the renamed and ex-
isting files. To overwrite the existing file press Enter or acti-
vate the Overwrite button. Press Escape or activate the Can-
cel button to return to the original rename dialog, the file that
prompted the overwrite dialog will remain active.

Automatic renaming of multiple
files

To automatically rename the files in the list, enable the Auto
rename check box. The dialog will change to batch mode for
numerical naming of files.

The file name list will change to include a preview column that
will show the resulting name of each file. The text entry will
change to three entries; the first represents the text that appears
in the new names before the number, the second will be the
start number to use when incrementing the file number, and the
third represents the text to append to the name after the number.
The end text should include the file name extension, therefore
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batch renaming multiple types of files (those with different ex-
tensions) all at once is not recommended.

The padding number can be used to change the minimum
length of characters to use for the number portion of the new
name. When the file number results in fewer characters than
the padding size, the result will be padded with leading zeros
to fill the remaining space. For example if padding size is 3, a
file with the number 24 will appear in the file name as “024”.

The order of the file list can be changed by dragging a name
to the desired location within the list. The preview column will
update to reflect the new order.

When the preview of new names is satisfactory, press Enter
or activate the Rename button to rename the files to match the
name in the preview column. Press Escape or activate the Can-
cel button to close the dialog and abort the rename operation.

If the resulting new names match any existing files, a warning
dialog will notify you. The rename dialog will remain so that
you can select a different set of names.

Formatted renaming of multiple
files

Formatted rename permits file to be renamed in a pre-deter-
mined way whilst still including the original file name.

In the Format box any alpha-numerics can be entered, but the
special character * will be replaced by the current filename.
One or more # characters can be included, and will be replaced
by an incrementing number.

The current file extension is automatically appended to new
new file name.

The order of the file list can be changed by dragging a name
to the desired location within the list. The preview column will
update to reflect the new order.

When the preview of new names is satisfactory, press Enter or
activate the Rename button to rename the files to match the
name in the preview column. Press Escape or activate the Can-
cel button to close the dialog and abort the rename operation.

If the resulting new names match any existing files, a warning
dialog will notify you. The rename dialog will remain so that
you can select a different set of names.

Delete
To delete a file in Geeqie select File → Delete (Ctrl+D) . Delete is also available in the context menu
of all images and files. If Enable delete key is enabled in Options, pressing the Delete key can also
be used to delete files.

The behavior when starting a delete operation depends on the Confirm file delete option in Options. If
the option is enabled a dialog will appear to confirm the operation, if it is not enabled the files will be
deleted without further interaction. In all cases if the file is unable to be deleted you will be notified
by a dialog.
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Confirm delete dialog
The dialog that appears when delete confirmation is enabled will show the file or files to be deleted.
To delete the file press Enter or activate the Delete button. Pressing Escape or activating the Cancel
button will close the dialog and abort the operation.

When deleting multiple files, the dialog will include two arrow buttons to step the image preview
through the list of files to be deleted. Initially the preview will be blank, activate the right arrow to
display the first file.

The dialog will also display the status of the Safe Delete feature. Use this to determine if a file to be
deleted will be immediately lost, or if the file can possibly be recovered from the Safe Delete folder.

If a file is unable to be deleted, a dialog will appear to notify you. If multiple files were selected and
any remain, the dialog will include a Continue button, activating this button or pressing Enter will
delete the remaining files. Pressing Escape or activating the Cancel button will close the dialog and
the remaining files will not be deleted.

Safe Delete
Geeqie includes a feature to temporarily store deleted files in a selected folder, to use this feature
enable Safe Delete on the advanced tab of the preferences dialog.

Cache and Data Maintenance
Thumbnails and other cached data can be maintained from the dialog accessible by selecting Edit →
Cache maintenance .

Geeqie thumbnail and sim. cache
The utilities listed here operate on the Geeqie caching mechanism. This also includes the data cached
for the search and find duplicates utilities.

Clean up Removes thumbnails, sim. files, and data for which the source
image is no longer present, or has been modified since the
thumbnail was generated.

Clear cache Removes all thumbnails, sim. files, and data stored in the des-
ignated folder.

Shared thumbnail cache
The utilities listed here operate on the shared thumbnail mechanism.

Clean up Removes thumbnails for which the source image is no longer
present, or has been modified since the thumbnail was gener-
ated.

Clear cache Removes all thumbnails stored in the designated folder.

Create thumbnails
This utility will render thumbnails using the current thumbnail caching mechanism, as determined in
Preferences .
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Render Pre-render thumbnails for a specific folder, the utility has the
following options:

Include subfolders Enable to include all images contained in the subfolders of fold-
er.

Store thumbnails local to source
images

The generated thumbnails will be stored local to the source im-
ages, if you have the permissions to write to the folder contain-
ing the images.

Create file similarity cache
Some file operations, such as search and find duplicates , are speeded up if similarity data files for the
images have been created. This utility will create sim. files recursively under the specified folder.

The sim. files contain some or all of the following fields:

Dimensions width x height

Date Exif date in time_t format

checksum MD5sum 32 character ascii text digest

SimilarityGrid [32 x 32] = 3072 bytes of data (1024 pixels in RGB format, 1
pixel is 24bits)

Metadata
This utility operates on the data store for Metadata located in the folder:

$HOME/.local/share/Geeqie/metadata

Clean up Removes keywords and comments for which the source image
is no longer present.

Background Cache Maintenance
This facility will run the command line program described below as a stand-alone background job.

Command line program
Geeqie can be run as a command line program: GQ_CACHE_MAINTENANCE=y[es] geeqie --
cache-maintenance <path to images>. It will recursively remove orphaned thumbnails
and .sim files, and create thumbnails and similarity data for all images found.

It may also be called from cron or anacron thus enabling automatic updating of the cached data
for all your images.
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Chapter 8. Color Management
TBD.

Color management options
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Chapter 9. Image Presentation
Geeqie can be used to display a set of images, showing each image for a period of time before changing
to the next image. Images can also be set to fill the entire screen.

Slide Show
The image pane can be set to automatically change the displayed image after a period of time, in
Geeqie this is referred to as a slide show.

Starting a slide show
A slide show can be started in a number of ways:

• From the keyboard or mouse View → Toggle slide show (S)
• From a context menu - right click an image pane, and select Start slide show , or Stop slide show

; the text will change depending on the state of the current slide show.

Stopping a slide show
An active slide show can be stopped by using the same functions available to start one, as they work
like a toggle switch. If slide show repeat is not enabled in the Preferences dialog , the slide show will
stop when the last image in the sequence is displayed.

Any action that changes the image pane to a new image will stop the active slide show, with the
exception of the methods discussed in Slide show sequence navigation .

Slide show status
The main window status bar can be used to determine when a slide show is active, Slide show will
be displayed next to the file count field. An individual Image Window can also display a slide show,
however the status will not be immediately visible. To determine the slide show status in an image
window, open a context menu by right clicking or using the menu key, the slide show menu item will
reflect the slide show status; if Start slide show is displayed, no slide show is active, conversely if
Stop slide show is displayed a slide show is active.

When a Slide show is paused, the main window status bar will display Paused instead of Slide show .
Likewise, the image context menu will display Pause slide show or Continue slide show , depending
on the current state.

Pausing a slide show
An active slide show can be paused in two ways:

• From the keyboard - press the P key while a slide show is active.
• From a context menu - right click the image pane displaying the slide show, and select Pause slide

show , or Continue slide show depending on the current slide show state.

Selecting the images to include in a slide show
When a single image is selected, all images in the current folder are included in the slide show. The
sequence will begin with the current image; however if random slide shows are enabled, the sequence
will begin with a random image from the list.
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To only include some images in a slide show, use multiple selection to select the images to include
before starting the slide show.

An image collection can be used as the list of images, to do this drag an image from a collection
window onto the image pane. Starting a slide show will then include the images from that collection.

So far, the methods described are for slide shows in a main window, in an Image Window , the slide
show will use all images referenced by that window.

Recursive slide show
In the main window, a recursive slide show can be started from a folder's context menu; the folder's
right click menu will include two slide show options:

• Slide show: This will start a slide show that includes all images in the selected folder.
• Slide show recursive: The slide show will include all images in the selected folder, and all images

in the folders that are contained within the selected folder.

Slide show sequence navigation
When a slide show is active, functions that normally change the image forward and backward can be
used to step through those contained in the slide show.

Configuring a slide show
The options that control the behavior of slide shows are located on the General tab of the options dialog.

Full Screen
Geeqie allows for the image pane to be expanded to fill the entire screen, this is referred to as full
screen.

Turning on full screen
Full screen can be activated in a number of ways:

• View → Full screen (F)
• From a context menu - right click an image pane, and select Full screen .

Turning off full screen
To return to the normal view:

• From the keyboard - press F or Esc to stop full screen.
• From a context menu - right click the image pane, and select Exit full screen .
• From the menu bar - the menu bar may be visible when using multiple monitors, select View →

Full screen (F)

Configuring full screen
Full screen behavior and location can be adjusted on the Windows tab of the preferences dialog.
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Navigation
Refer to Keyboard and Mouse Shortcuts .
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Chapter 10. Printing
To print an image select File → Print (Shift+P) .

Printing is provided by the standard Gtk printer services. The Options tab provides Geeqie-specific
features.

Options tab
Image Text This text will be attached to each image printed. It may contain

any combination of plain text and predefined tags.

Page Text This text will also be attached to each image printed. It may
contain only plain text.

It is probably of value only when one image per page is printed.

Header 1/2 Footer 1/2 These checkboxes define the layout for Image Text and Page
Text. Image and Page Text may be printed above or below each
image and in the order defined by these checkboxes.
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Chapter 11. Preferences
There are two sets of preferences in Geeqie: those set via the main Preferences tabbed dialogue, and
those set either via a menu entry or by editing a configuration file.

This chapter explains in detail the main Geeqie preferences dialog, which is accessed via Edit →

Preferences (Ctrl+O) or  on the Toolbar.

General Options
This section describes the options presented under the General Tab of the preferences dialog.

Thumbnails
Size Selects the size of the thumbnails displayed throughout Geeqie,

dimensions are width by height in pixels.

Quality Selects the method to use when scaling an image down for
thumbnails:

Nearest Fastest scaler, but re-
sults in poor thumbnail
quality.

Tiles Thumbnail results are
very close to bilinear,
with better speed.

Bilinear High quality results,
moderately fast.

Cache thumbnails and sim. files Enable this to save thumbnails and sim. files to disk. Subse-
quent requests for a thumbnail will be faster, as will searches
and find duplicates.

Use Geeqie thumbnail style and
cache

Thumbnails are stored
in a folder hierarchy
that mirrors the loca-
tion of the source im-
ages. Thumbnails have
the same name as the
original appended by
the file extension .png.

The root of the hierar-
chy is:

$XDG_CACHE_HOME/
geeqie/thumb-
nails/ or, if
$XDG_CACHE_HOME
is not defined:
$HOME/.cache/
geeqie/thumb-
nails/
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Store thumbnails local to image
folder (non-standard)

When enabled, Geeqie
attempts to store cached
thumbnails closer to the
source image. This way
multiple users can ben-
efit from a single cache,
thereby reducing wast-
ed disk space.

Thumbnails have the
same name as the origi-
nal appended by the file
extension .png.

The resulting location is
the source image's fold-
er, in a sub folder with
the name .thumb-
nails

When the image source
folder cannot be writ-
ten, Geeqie falls back to
saving the thumbnail in
the user's home folder.

Use standard thumbnail style and
cache, shared with other applica-
tions

This will use a thumb-
nail caching method
that is compatible with
applications that use
the standard thumbnail
specification. When this
option is enabled
thumbnails will be
stored in:

$XDG_CACHE_HOME/
thumbnails/ or, if
$XDG_CACHE_HOME
is not defined:
$HOME/.cache/
thumbnails/

All thumbnails are
stored in the same fold-
er, with computer-gen-
erated filenames. Refer
to Thumbnails Refer-
ence for additional de-
tails.

Use EXIF thumbnails when avail-
able

Geeqie will extract thumbnail from EXIF data if available, in-
stead of generating one. This will speed up thumbnails gener-
ation, but the EXIF thumbnail may be not in sync with the im-
age if it was modified by a tool which did not also update the
thumbnail data.

Thumbnail color management Where possible store thumbnails with an sRGB color profile.
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Note

Selecting this option will increase the time taken to
generate thumbnails.

You probably will want to deselect the "Use EXIF
thumbnails" option.

Collection preview If thumbnail caching is enabled and you open the Collections
folder , Geeqie will display a preview of the collections as a
thumbnail montage. This option limits the number of thumb-
nails displayed in each preview.

Note

ImageMagick is required for this feature.

Star Rating
The characters used to display the Star Rating are defined here. They are defined as a hexadecimal
Unicode character. The complete list of Unicode characters can be found in many places on the In-
ternet.

Slide show
Delay between image change Specifies the delay between images for slide shows, in seconds.

Random When enabled, slide show images will appear in random order.

Note

Random images are displayed such that each image
appears once per cycle of all images. When the slide
show repeat option is enabled, the image order is ran-
domized after completing each cycle.

Repeat This will cause the slide show to loop indefinitely, it will con-
tinue with the first image after displaying the last image in the
slide show list.

Image loading and caching
Decoded image cache size Limit the amount of memory available for caching images.

Preload next image Enabling this option will cause Geeqie to read the next logical
image from disk when idle, it will also retain the previously
viewed image in memory. By reading the nearest images into
memory, time to display the next image is reduced.

Note

This option will increase Geeqie memory require-
ments, and may cause performance issues with very
large images. If the use of Geeqie results in the system
noticeably swapping memory to disk, try disabling
this feature.
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Refresh on file change Geeqie will monitor currently active images and folders for
changes in their modification time, and update the display if it
changes.

Note

Disable this if the system will not go into sleep mode
due to occasional disk activity from the time check,
or if Geeqie updates too often for folders with contin-
uously changing content.

Menu style
Use a ≡ "hamburger" style menu button instead of the standard menu across the top of the frame.

Note

Geeqie must be restarted for changes to take effect.

Expand menu/toolbar
Expand the menu/toolbar to the full width of the window.

Note

Geeqie must be restarted for changes to take effect.

Hide Selectable Bars
The menu item Hide Selectable Bars will toggle display of the bars selected here. The default keystroke
for this action is control + backtick

Note

Geeqie must be restarted for changes to take effect.

AppImage updates notifications
Show a notification on start-up if the server has a newer version than the current. Requires an Internet
connection. Displayed only if an AppImage is being run.

Show predefined keyword tree
Deselecting this option will hide the list of predefined keywords on the right-hand side of the keywords
pane of the info sidebar.

Note

Geeqie must be restarted for the change to take effect.

Timezone Database
The timezone database is used to correct exif time and date for UTC offset and Daylight Saving Time
as described here. This option allows you to install or update the database. An Internet connection
is required.

59



Preferences

On-line help search
An internet search engine may be used to search the help files on Geeqie's website. The string used to
conduct the search is defined here. In most cases it will be in one of two formats:

https://www.search-engine.com/search?q=site:geeqie.org/help

https://www.search-engine.com/?q=site:geeqie.org/help'

Image Options
This section describes the options presented under the Image Tab of the preferences dialog.

Zoom
Quality Selects the method used to scale the size of an image:

Nearest Fastest scaler, but re-
sults in poor image
quality.

Tiles Results are somewhat
close to bilinear, with
better speed.

Bilinear High quality results,
moderately fast.

Two pass zooming Enables Geeqie to first display a scaled image using the Nearest
zoom quality. After image decoding is complete, the image is
scaled again using the selected Zoom Quality method. This al-
lows faster display of an image as it is decoded from the source
file.

Zoom increment Adjusts the step size when zooming in or out on an image.

Zoom style Selects whether the zoom step size is applied as a geometric (n
* step) or arithmetic (n + step) factor.

Fit Image To Window
Allow enlargement of image (max.
size in %)

Enable this to allow Geeqie to increase the image size for im-
ages that are smaller than the current view area when the zoom
is set to Fit image to window . This value sets the maximum
expansion permitted in percent i.e. 100% is full-size.

Virtual window size (% of actual
window)

This value will set the virtual size of the window when Fit im-
age to window is set. Instead of using the actual size of the win-
dow, the specified percentage of the window will be used. It al-
lows one to keep a border around the image (values lower than
100%) or to auto zoom the image (values greater than 100%).
It affects fullscreen mode too.

Tile Size
Tile size in pixels This option is only available when GPU acceleration is not se-

lected. It sets the size in pixels that large images are split into
during rendering. Setting a larger value will reduce the tiling
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effect seen as the image is displayed, but will also slightly in-
crease the delay until the first part of the image is seen.

Appearance
Custom border color Enable this to draw the image background (the area around the

image) in the specified color.

Border color Use this color chooser to define the color to use as image back-
ground.

Note

You may use the Virtual window size (see above) op-
tion to keep a border around the image in fullscreen
mode.

Alpha channel color 1/2 These two colors define the checkerboard background used
when images with an alpha channel are displayed.

OverlayScreen Display
This section describes the options presented under the OSD Tab of the preferences dialog.

Overlay Screen Display
The contents of the Overlay Screen Display is defined by the Image Overlay Template. This template
is easily customised to display a wide range of data.

The format of each entry is:

%tag[:max_length][:extra]%

Table 11.1. Overlay Screen Display templates

Tag Replaced by

name Filename of the picture

path Full path, including filename, of the picture

collection Name of the collection

number Current number of image in the list

total Total number of images

date File date

size File size

width Image width

height Image height

res Image resolution

keywords Image keywords from metadata

comment Image comment from XMP metadata

imagecomment JPEG image comment

rating Image rating

<meta_tag> The Exif, XMP, or IPTC tag from metadata

lua/<lua_script>/ The output of a Lua script file
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lua//<lua_command> The output of a Lua command

As an aide, in addition to standard metadata tags, Geeqie provides a number of pre-formatted tags .

Examples of usage are:

        %keywords%
        %Exif.Photo.DateTimeOriginal%
        %lua/jpeg_comment.lua/:12%
        %lua//return(os.date())%
      

Refer to Lua Extensions for further information.

The length of displayed data can be limited by using the :max_length parameter. The following ex-
ample will truncate the displayed data to 20 characters and will add 3 dots at the end to denote the
truncation.

%formatted.Camera:20%

If two or more variables are connected with the | character, the variables are displayed with a separator.
For example::

%formatted.ShutterSpeed%|%formatted.ISOSpeedRating%|
%formatted.FocalLength%

could show:

"1/20s - 400 - 80 mm"

Or, if there is no ISO information in the Exif data:

"1/200 - 80 mm"

If there is no data for a requested tag, the line is not displayed.

The :extra parameter may be used to format the output by prepending and appending a text string to
the displayed item.

The special character * is used to mark the position of the Tag data item. If no * is present, the extra
string is just appended to the standard data displayed. Any "\n" is replaced by a newline on display.
Pango mark up is accepted in both left and right parts. If the data item is empty, nothing will be
displayed.

Examples:

Table 11.2. Overlay Screen Display template examples

Template Example display

%name: <i>*</i>\n% filename001.jpg

%size:\n% 123456

%formatted.ISOSpeedRating:ISO *% ISO 100

%collection:Collection: <b>*</b> \n% Collection: my_new_collection

Font ,  Text ,  Back-
ground

The font used for the Overlay Screen Display, as well as the font
colour and background colour, may be set via these buttons.
Colour transparency can also be set.
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Help

Show syntax help

Defaults Restore default image overlay template

Window Options
This section describes the options presented under the Windows Tab of the preferences dialog.

State
Remember session This will maintain windows size and position between Geeqie

sessions.

Use saved window positions also
for new windows

A new window opened by menu File → New Window (Ctr-
l+N) will use the saved window positions also.

Remember window workspace Remember which workspace a window was displayed in.

Remember tool state Maintains the selection set by View → File and Folders → Float
File List (L)

Remember dialog window posi-
tions

This will maintain dialog windows size and position between
Geeqie sessions.

Hide window decorations By default, windows are decorated with a title bar, resize con-
trols, etc. If this option is selected, some window managers may
be able to disable these decorations, creating a borderless win-
dow.

Show window IDs Show the window ID in the titlebar of each window. When mul-
tiple Geeqie windows are opened, this option shows a unique
identifier for each window. It may be used in conjunction with
the command line option:  --id=<ID>

Use current layout for default Press the Set button to store the current window layout for use
as the default for all new windows.

Size
Fit window to image when tools are
hidden/floating

The main window will be resized to accommodate each image's
size and proportions when the image pane is the only one vis-
ible within the window.

Limit size when auto-sizing win-
dow

This will restrict the maximum size a window can grow to au-
tomatically fit an image. The value represents the percentage
of the desktop size in width and height.

Full Screen
Location Selects the location and position of the full screen window. 'De-

termined by window manager' will leave the window place-
ment up to the window manager. 'Active screen' places the win-
dow on the same screen as the Geeqie main window. 'Active
monitor' does the same, but limits the full screen window size to
the monitor containing the main window. The remaining choic-
es are dependent on the multiple monitor configuration.
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Smooth image flip This option delays the image change in full screen until the next
image is entirely decoded into memory, the result is a smoother
transition between images.

Disable screen saver This option will execute xscreensaver-command --deactivate
once per minute to avoid the screen saver from activating when
Geeqie is displayed full screen.

Keyboard Options
This dialogue enables changes to be be made to the default key short-cut allocated to menu items.

The data displayed may be ordered by clicking at the top of each column.

To change or create a new short-cut, double click on the KEY column of the relevant item. The text
displayed will change to "New accelerator...". Press the key combination required for this action.

Only shortcuts in the main window can be redefined. Shortcuts in other windows are fixed.

A text search may be made in any of the columns. Click anywhere in a column and type characters.
The search is case-insensitive

File Filters Options
This section describes the options presented under the File Filters Tab of the preferences dialogue.

Filters
Show hidden files or folders Enables the display of hidden files and folders, also known as

dot files.

Show parent folder Enables the display of the parent folder as a double dot in the
directories views.

Case sensitive sort (Collection and
Search windows, and tab comple-
tion)

Files and folders are sorted such that upper case letters occur
before lower case letters.

Enabled result: A, B, C, a, b, c

Disabled result: A, a, B, b, C, c

Disable file extension checks During rename operations, allows files to be renamed to a dif-
ferent extension with no warning issued.

Disable file filtering Enable this to allow Geeqie to list all files, even those that do
not contain images.

Grouping sidecar extensions
This field defines which extensions will lead to file grouping. Grouped files will appear as a single
entry in file views. This is useful, for example, when browsing directories containing two files for the
same image (such as raw+jpeg files generated by some cameras).

The group is represented by the first extension in the list for which a file exists.

Each extension should include the starting dot and should be separated by a semi-colon from following
entries. It is possible to use wild-cards corresponding to entries in the File Types Class below:
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%unknown expands to all files listed in class Unknown ,

%image expands to all files listed in class Image ,

%raw expands to all files listed in class RAW Image

%meta expands to all files listed in class Metadata

File types
This list contains the image formats that are understood by Geeqie. To disable a specific file type from
being displayed, uncheck it's corresponding check-box. Filters can be edited by first selecting the line
containing the item to be changed, then clicking the filter or description field, making any changes,
then pressing Enter ; press Escape to cancel an active edit.

Note

Unlike all other options in the dialogue, filter list changes are applied immediately.

The table consists of:

Enabled Whether or not the filter is used.

Filter List of extensions this filter applies to, separated by a ; . Each
extension must be preceded by a dot.

Description Brief description. This is not used elsewhere.

Class This may be used to define sets of file types, for use in the
Grouping function described above. The drop-down list has 7
entries:

• Unknown

• Image

• RAW Image

• Metadata

• Video

• Collection

• Document

• Archive (.zip, .rar etc.)

Writable If this option is checked, Geeqie will try to write metadata to the
image file itself. This, and the following option, are mutually
exclusive.

Sidecar is allowed If this option is checked, Geeqie will try to write metadata to
a sidecar file associated with the image. This, and the previous
option, are mutually exclusive.

Add

Adds a new blank line to the filter list, change the parameters
to match the desired file type.
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Remove

Removes the selected line from the filter list.

Defaults Resets the filter list to the default values, discarding any cus-
tomizations made by the user.

Column Sorting Columns other than Filter can be sorted in ascending or de-
scending order by clicking on the column header.

Filter Search A search of the file extensions listed in the Filter column can
be initiated either by typing Ctrl + F or by pressing any
alpha-numeric key when the File Types table has focus.

Metadata
This section describes the options for metadata writing.

Refer also to Metadata Processing in the Reference section.

Metadata writing process
When writing metadata, Geeqie will follow these steps. This process will stop when the first successful
write occurs. A flowchart showing the sequence is here .

1. Save metadata in image files or sidecar files, according to the XMP standard

If checked, Geeqie will attempt to write metadata to the file itself, or to an associated XMP sidecar
file

The destination is dependent on the settings in the "Writable" and "Sidecar Is Allowed" columns
of the File Filters tab .

2. Save metadata in '.metadata' folder, local to image folder (non-standard)

If checked, Geeqie will attempt to write to an xmp file in a local .metadata folder

3. Save metadata in Geeqie private directory

If neither of the above are successful, Geeqie will write to an xmp file in the folder

$HOME/.local/share/geeqie/metadata

When writing to local metadata folders, the directory structure duplicates that of the location of the
source files.

Step 1 Options:
If Step 1 above was successful, the following options take effect:

• Store metadata also in legacy IPTC tags (converted according to IPTC4XMP standard)

If checked, Geeqie will write IPTC tags as defined in Standards

The conversion from XMP tag to IPTC tag is performed by exiv2. A list of the XMP-IPTC conver-
sions is at the end of this table [https://exiv2.org/conversion.html] .

• Warn if the image files are not writeable

If checked, open a warning dialogue if the file is not writeable

• Ask before writing to image files
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If checked, open a confirmation dialogue before writing to the file

• Create sidecar files named image.ext.xmp (as opposed to image.xmp)

If checked, new sidecar files will use image.ext.xmp naming scheme. This scheme is used by Dark-
table.

Steps 2 and 3 Option:
If Step 2 or 3 above was successful, the following option takes effect:

• Use GQview legacy metadata format (supports only keywords and comments) instead of XMP

If checked, Geeqie will write metadata in GQview legacy files (file extension .meta) format

Miscellaneous
• Write the same description tags to all grouped sidecars

If checked the same descriptive tags are written to all files in a group. File grouping is as defined in
the File Filters tab of main Preferences. Technical tags (exif) are handled separately for each file.

The tags written are:

          "Xmp.dc.title"
          "Xmp.photoshop.Urgency"
          "Xmp.photoshop.Category",
          "Xmp.photoshop.SupplementalCategory",
          "Xmp.dc.subject",
          "Xmp.iptc.Location",
          "Xmp.photoshop.Instruction",
          "Xmp.photoshop.DateCreated",
          "Xmp.dc.creator",
          "Xmp.photoshop.AuthorsPosition",
          "Xmp.photoshop.City",
          "Xmp.photoshop.State",
          "Xmp.iptc.CountryCode",
          "Xmp.photoshop.Country",
          "Xmp.photoshop.TransmissionReference",
          "Xmp.photoshop.Headline",
          "Xmp.photoshop.Credit",
          "Xmp.photoshop.Source",
          "Xmp.dc.rights",
          "Xmp.dc.description",
          "Xmp.photoshop.CaptionWriter",
          "Xmp.xmp.Rating",
        

• Allow keywords to differ only in case

If checked, permits keywords to be case-sensitive (e.g. Place and place are two different keywords)

• Write altered image orientation to the metadata

If checked, the results of orientation commands (Rotate, Mirror and Flip) issued on an image will be
written to metadata either automatically as specified below or when manually initiated. This option
also affects the Auto rotate image using EXIF information menu item.
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Warning

If this option is not checked, the results of orientation commands will be lost when Geeqie
closes.

Do not change this option while you have temporary rotations applied to images.

Auto-save options

• Write metadata after timeout

If checked, metadata writes will be made automatically at the defined interval. Warning dialogues
will be issued if required.

• Write metadata on image change

If checked, metadata writes will be made when you move focus to another image.

• Write metadata on directory change

If checked, metadata writes will be made when you move focus to another folder.

Spelling Checks

If selected, spelling checks will be enabled on the following panes:

• Title

• Comment

• Headline

Pre-load metadata

• Read metadata in background

Using the folder sorting options:

Exif date original

Exif date digitized

Rating

requires metadata to be read from all files in a folder before the sort action can be made. If a folder
contains a large number of file, this can take a noticeable period of time.

If this option is checked, Geeqie will automatically read the required metatada in the background
as soon as a folder is opened. This will reduce the amount of time you have to wait until the sort
is completed.

If you do not use these sort options, leave this option unchecked.
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Metadata Write Sequence Flowchart
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Keywords
This section describes the keywords list used for autocompletion.

Keyword Search

Pressing the Search button will open a dialog which permits a recursive search to be made for keywords
already attached to images. The result of the search is automatically appended to the existing list.

Keyword List

The list shows all keywords currently used for autocompletion. Text may be copy-pasted into the list
or deleted from the list.

When the list is saved, duplicates will automatically be removed and the list sorted into alphabetical
order.

Color management options
Use of this function requires LCMS to be installed. If you are compiling from sources, LCMS func-
tionality will be available if the development files dependencies are met.

If you are using a pre-compiled distribution, availability depends on the package maintainer.

Here one can defined color profiles to use. Color management can be enabled or disabled from View

→ Color Management or  on the status bar.

Type Either input color profile or screen color profile.

Menu name Name of the menu entry corresponding to the color profile.

File Path to the color profile file.

Stereo image management
TBD

Behavior Options
This section describes the options presented under the Behavior Tab of the preferences dialog.

Delete
Confirm permanent file delete Prompts for confirmation before deleting files.

Confirm move file to Trash Prompts for confirmation before moving files to the trash bin.

Enable Delete key Disable this to disassociate the delete file function from the
Delete key.

If Confirm file delete , above, is disabled, accidentally hitting
the Delete can result in files being erroneously deleted without
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warning. Disabling the Delete key will prevent this. The  Ctrl
+ D  key sequence is not affected.

Use Geeqie trash location Moves deleted files to a temporary folder, for easy retrieval of
deleted files. Files in the temporary folder are retained until the
maximum size is reached, at which point deleting additional
files will result in the removal of the oldest files to reclaim the
space needed for the new files.

Note

Files moved to the Safe Delete folder are prefixed with
a six digit number in the format: nnnnnn_FILE-
NAME

This is used by the delete feature to distinguish which
files to remove first when clearing space for new files.

The digit counter increments with each deleted file.

Use system Trash bin Moves deleted files to the system-defined trash bin.

Folder The location of the folder used by the Safe Delete feature.

Maximum size The size to use for the Safe Delete folder, in megabytes. Note
that setting this value to 0 (zero) will disable any limit.

Clear button Removes all files contained in the Safe Delete folder.

View button Changes the Geeqie main window to display the contents of the
Safe Delete folder.

Behavior
Descend folders in tree view This will allow Geeqie to read sub folder content to determine

if it should display expander indicators in the folder tree view.

Note

Disable this if Geeqie wakes up auto mounted network
shares, or takes too long to initially display the folder
view.

In place renaming When renaming a single file, this will allow the rename entry
to appear directly over the original filename.

List directory view uses single
click to enter

If selected, a single click will enter a directory, rather than the
GTK+ default of a double click.

Circular selection lists If selected, when traversing a list of selected images using Next
or Previous Image, when the last or first image is encountered
the focus moves to the beginning or end of the list. When des-
elected, focus will go no further than the start or end of the list.

Save marks on exit Save all marks that have been set. Note that marks that are
linked to a keyword will always be saved irrespective of this
setting.

Use "With Rename" as default for
Copy/Move dialogs

Move the "With Rename" button to the default position.
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Permit duplicates in Collections If this option is set, an image can be inserted into a Collection
any number of times.

Open Collections on top Open collection windows with "Always on Top" set.

Hide window in fullscreen When alt-tabbing, prevent Geeqie window showing twice.

Hide OSD in fullscreen Hide Overlay Screen Display in fullscreen mode.

Recent folder list maximum size This is the maximum number of entries to be displayed in the
recent open folder list drop-down box.

Recent folder-image list maximum
size

The last image viewed in a folder is stored in a list. This value
is the maximum number of entries in the list. When a folder is
subsequently re-opened, focus moves to the last image viewed
in that folder.

Drag'n drop icon size This is the width and height of the icon generated from image
and displayed when doing drag and drop actions. High resolu-
tion screens may require to increase this number.

Drag'n drop default action When using drag and drop to copy or move files, the default
action is to use a pop-up menu to permit you to select which
action is to be taken. This option allows you to set the default
action to either Copy or Move.

Note

When using the pop-up menu, the menu will also in-
clude an option for a symbolic link and any other plu-
gins that are defined as being a filter. If you set the de-
fault action to Copy or Move these additional options
will not be available to you.

Copy path clipboard selection This option determines which clipboard selection is used for the
"Copy path" menu item. The exact method of the paste opera-
tion will depend on the operating system, but in general will be:

Primary Paste using mouse mid-
dle-click, or shift-insert.

Clipboard Paste using mouse
right-click and select
paste, or control-v.

Both Paste using either
method.

Navigation
Progressive keyboard scrolling This will cause image panning speed to gradually accelerate

when holding down the keyboard arrows.

Keyboard scrolling step multiplier: Defines the amount to pan an image when using the keyboard
arrows.

Mouse wheel scrolls image The default is for the mouse wheel to change the image, and
to scroll the image when Shift is used in combination with the
wheel. Enabling this swaps the behavior so that operating the
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wheel will scroll the image, and holding down Shift will change
the image.

Navigation by left or middle click
on image

If selected, mouse left-click will select the next image; mouse
middle-click will select the previous image.

Open archive by left click on image If selected, mouse left-click on an image belonging to the
archive class will decompress the file contents and display them
in a new Geeqie window.

Play video by left click on image If selected, mouse left-click on an image belonging to the video
class will start a program chosen in a box below.

Mouse button Back/Forward Some mice have additional buttons designated Back/Forward
(mouse buttons 8 and 9). You may allocate any menu item to
either of these buttons.

Debugging
Debug level Displayed when compiled with the option --enable-debug-log.

This defines the verbosity of debug info sent to console and log
window (0 disables the debug output).

Log Window max. lines The maximum number of data lines to be displayed. The win-
dow will show the most recent data.

Toolbar
This dialogue enables you to change the items displayed on either the Main Toolbar or the Status
Toolbar.

The initial display shows the current setup. You may re-order these items by right-clicking on any item.

Additional items may be included by clicking on the "Plus" symbol at the bottom of the tab. A list
of all available options is displayed.

Most of the Geeqie menu items are available, plus any desktop (Plugins) files.

Note

If you select a desktop file, ensure that it includes an icon - the desktop file format is described
in the Standards section

Advanced

External preview extraction
The intention of this feature is to give the user the possibility to display image previews of files that
the standard libraries cannot decode.

An example is the .dng files produced by LG V30 cameras. Neither exiv2 nor libraw can extract
a preview, but the command line program dcraw can.

This feature allows a work-around until the standard libraries provide a solution.

Two command files are required: one to identify which files to process, and one to extract or decode
the preview image.
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The format for the identification tool is:

        Parameter 1: (input) full path name to the current image.
        Returns: 0 for file match, any other value for no match.
      

The format for the extraction tool is:

        Parameter 1: (input) full path name to the current image.
        Parameter 2: (output) a temporary file name generated by Geeqie.
        Returns: not used.
      

The tool should load the output file with the decoded image.

This is an example of an identification tool using a shell script:

#! /bin/bash

        filename=$(basename -- "$1")
        extension="${filename##*.}"

        shopt -s nocasematch
        if [[ $extension == "DNG" ]]
        then
        cameramodel=$(exiv2 -K Exif.Image.UniqueCameraModel -Pt "$1" )
        if [[ $cameramodel  == "LG-H930" ]]
        then
        exit 0
        else
        exit 1
        fi
        else
        exit 1
        fi

This is an example of an extraction/decode tool using a shell script:

#! /bin/bash
          dcraw -e -c   "$1" > "$2"

Alternatively:

#! /bin/bash
          gm convert "$1" "$2"

If the decode tool requires an output file with a particular extension, use this method:

#! /bin/bash
          tmpfile=$(mktemp --tmpdir=$tempdir geeqie_tmp_XXXXXX.jpg)
          gm convert "$1" $tmpfile
          mv $tmpfile "$2"

Thread Pools
This option will limit the number of threads (cores) that are used when performing a duplicate image
search. A value of 0 means use all available threads. This will give the fastest processing time, but
will slow other processes including user input response time.
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Alternate Algorithm
Alternate Similarity Algorithm
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Chapter 12. Additional Preferences
There are two sets of preferences in Geeqie: those set via the main Preferences tabbed dialogue, and
those set either via a menu entry or by editing a configuration file.

This chapter explains in detail the Geeqie preferences that are set via a menu entry or by editing a
configuration file.

Window Layout
This item is accessed via Edit → Configure this window .

Home Path

The path to be moved to when    is clicked.

Show date in directories list view The folder pane will show dates.

Start-up directory This may be set for each instance of Geeqie.
• No change: Use the Current Working Directory. If called

from a system menu rather than the command line, the Home
directory will probably be used.

• Restore last path: Use the folder in use when Geeqie was
previously closed.

• Home path: Use the folder specified in the Home Path box.

Layout The Geeqie main window consists of three main panes: the
folder pane , file pane and the image pane . Their position and
order can be changed here. The four choices shown represent
the basic layout of the main window, the difference being that
each has the larger pane in a different location: right, bottom,
left, and top.

The numbers within each selection represent the order of the
pane content.

The order in which the panes are filled is determined by the
three row list located below the layout selection. The three
numbered rows correspond to the three numbered regions of
the selected layout. To change the order of the list, drag a row
to the desired location within the list.

Note

In this dialogue the file and image panes are labeled
as such, however for historical reasons the folder pane
is labeled as tools.

Plugins Configuration

Plugins Configuration Dialog
This dialog allows user to add new plugins or modify the system ones. It is available in the menu Edit

→ Configure Plugins .

The Plugins dialog shows list of all relevant plugins i.e. all installed desktop files that are designated
either:
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• Categories=Graphics
• Categories=X-Geeqie

The list has the following columns:

Disabled If the checkbox is ticked, the plugin will not be displayed in
Geeqie menus.

Name Plugin name as specified in desktop file, and is the name dis-
played in menus.

Hidden A plugin can be Hidden for one of these reasons:

• the desktop file contains Hidden=TRUE or NoDis-
play=TRUE

• TryExec binary was not found

• MimeType list does not contain images

• MimeType list is empty and Categories does not con-
tain X-Geeqie

Desktop file Name of the desktop file, used as an identifier in Keyboard Op-
tions .

Path Full path to the desktop file. Desktop files in user directories
override the system ones with the same name.

Adding new plugin

New  opens a text editor with a desktop file template. You must amend the line

Exec=command %f

to contain the command you wish to execute. If it is more than a single command, you must create a
script file and call that. If the location of the script file is not in your $PATH environment variable,
you must include the full pathname.

Modifying an existing plugin

Edit  opens a text editor with existing desktop file. For desktop files that are not writable
by user, it allows saving to a Geeqie specific directory, where it overrides the system file (but only
for Geeqie).

Deleting a plugin

Delete  can delete user writable desktop files. System desktop files can't be deleted directly,
but it is possible to edit them and set Hidden=TRUE , see above.

Special plugins
A desktop file with one of the following names has a special function. It will replace the corresponding
internal command.

        geeqie-copy-command.desktop
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        geeqie-move-command.desktop
        geeqie-rename-command.desktop
        geeqie-delete-command.desktop
        geeqie-folder-command.desktop
      

This can be used for example for a custom trash command or for manipulation of files under version
control.

Geeqie desktop file keys
A desktop file for use only by Geeqie should have the following entries:

        Categories=X-Geeqie;
        OnlyShowIn=X-Geeqie;
      

A menu path where the plugin will appear, instead of in the default Plugins , can be set by including:

X-Geeqie-Menu-Path=<FileMenuPath>

Possible vales for FileMenuPath are:

        FileMenu
        FileMenu/OpenSection
        FileMenu/SearchSection
        FileMenu/PrintSection
        FileMenu/FileOpsSection
        FileMenu/QuitSection
        GoMenu
        SelectMenu
        SelectMenu/SelectSection
        SelectMenu/ClipboardSection
        SelectMenu/MarksSection
        EditMenu/EditMenu
        EditMenu/EditSection
        EditMenu/OrientationMenu
        EditMenu/RatingMenu
        EditMenu/PropertiesSection
        EditMenu/PreferencesSection
        PluginsMenu
        ViewMenu
        ViewMenu/WindowSection
        ViewMenu/FileDirMenu
        ViewMenu/FileDirMenu/FolderSection
        ViewMenu/FileDirMenu/ListSection
        ViewMenu/DirSection
        ViewMenu/ZoomMenu
        ViewMenu/ZoomMenu/ConnectZoomMenu
        ViewMenu/SplitMenu
        ViewMenu/StereoMenu
        ViewMenu/ColorMenu
        ViewMenu/OverlayMenu
        ViewMenu/ViewSection
        ViewMenu/ToolsSection
        ViewMenu/SlideShowSection
        HelpMenu
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        HelpMenu/HelpSection
      

If you want a plugin to use a user-definable path, the following entry must be made in the desktop file:

X-Geeqie-Filter=true

Desktop files containing this entry will be displayed in the Folder action list of the Sort Manager
Sidebar . The path of the bookmark clicked will be used by the desktop file.

If the desktop file is called from the menu, when the plugin is executed you are presented with a
dialogue which enables a path to be selected. The path selected, appended by the filename currently
being processed, is made available to the shell script either as an environment variable or via a call to
geeqie. The following code demonstrates the use of both methods:

        for file in "$@"
        do
        destination=$(geeqie --get-destination:"$file")
        
        echo "$destination"
        echo $GEEQIE_DESTINATION
        done
      

Note
A restart of Geeqie is required for this plugin to be registered

If you want to run a plugin in full-screen mode and wish full-screen to be maintained, include the
following entry in the desktop file:

X-Geeqie-Keep-Fullscreen=true

Any terminal output from the plugin command can be displayed with the following command:

X-Geeqie-Verbose=true

Any terminal output from the plugin command can be displayed, only when multiple files are selected,
with the following command:

X-Geeqie-Verbose-Multi=true

The plugin can be restricted to run on only certain file types, for example:

X-Geeqie-File-Extensions=.jpg; .cr2

The entries are case insensitive.

The key or key combination to execute this function can be set with:

X-Geeqie-Hotkey=

Key combinations are of the form:

X-Geeqie-Hotkey=<control>y

Note
This value may conflict with a setting in Keyboard Options

Legacy Configuration File Options
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This section describes the options not accessible by the graphical interface, these options exist to
maintain behavior of older releases of Geeqie. To change these settings, edit the Geeqie configuration
file .

lazy_image_sync: [true false ]  : This will suppress the image view from changing when selecting a
new folder; the current image will remain displayed until the user manually selects another image.

place_dialogs_under_mouse: [true false ]  : Enabling this will cause new dialogs to initially position
themselves such that they are under the current mouse position.

scroll_reset_method: value : This will set the method used to set the scroll position, or visible region
of a new image, value can be:

0: Move to upper left corner.

1: Center image.

2: Maintain same visible region as previous image, if possible.

thumbnails.use_xvpics = [true false ]  : xvpics is a common thumbnail caching format used by several
applications. Thumbnails are stored locally to the source image in a sub folder with the name .xvpics
. Enabling this option will allow Geeqie to read thumbnails saved in the xvpics format.

Note

Support for xvpics is read only, Geeqie can not generate thumbnails in this format.

80



Chapter 13. Reference
Command Line Options

81



Reference

Name
Geeqie — GTK based multiformat image viewer

DESCRIPTION

Geeqie is an interactive GTK based image viewer that supports multiple image formats, zooming,
panning, thumbnails and sorting images into collections.

Generated for version:

Usage:

geeqie [OPTION?] [path...]

Geeqie is an image viewer.

Version: Geeqie 2.5+git20250101-2ec35a8e

Help Options:

-h, --help Show help options

--help-all Show all help options

--help-gapplication Show GApplication options

--help-gtk Show GTK+ Options

Application Options:

--action=<ACTION> execute keyboard action (https://www.geeqie.org/help/
GuideReferenceRemoteKeyboardActions.html)

--action-list list available keyboard actions (some are redundant)

-b, --back previous image

--cache-metadata clean the metadata cache

--cache-render=<folder> render thumbnails

--cache-render-recurse=<folder> render thumbnails recursively

--cache-render-shared=<folder> render thumbnails (see Help)

--cache-render-shared-re-
curse=<folder>

render thumbnails recursively (see Help)

--cache-shared=clean|clear clear or clean shared thumbnail cache

--cache-thumbs=clear|clean clear or clean thumbnail cache

--close-window close window

--config-load=<FILE> load configuration from FILE

--debug=[level] turn on debug output

-d, --delay=<[H:][M:][N][.M]> set slide show delay to Hrs Mins N.M seconds,

--file=<FILE>|<URL> open FILE or URL bring Geeqie window to the top

--File=<FILE>|<URL> open FILE or URL do not bring Geeqie window to the top

--file-extensions list known file extensions
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--first first image

-f, --fullscreen start / toggle in full screen mode

--geometry=<W>x<H>[+<X-
OFF>+<YOFF>]

set main window location and geometry

--get-collection=<COLLECTION> get collection content

--get-collection-list get collection list

--get-destination=<FILE> get destination path of FILE (https://www.geeqie.org/help/
GuidePluginsConfig.html)

--get-file-info get file info

--get-filelist=[<FOLDER>] get list of files and class

--get-filelist-recurse=[<FOLD-
ER>]

get list of files and class recursive

--get-rectangle get rectangle coordinates

--get-render-intent get render intent

--get-selection get list of selected files

--get-sidecars=<FILE> get list of sidecars of FILE

--get-window-list get list of windows

-g, --grep=<regexp> filter debug output

--id=<ID> window id for following commands

--last last image

-o, --log-file=<file> save log data to file

--lua=<FILE>,<lua script> run lua script on FILE

--new-window new window

-n, --next next image

--pixel-info print pixel info of mouse pointer on current image

--print0 terminate returned data with null character instead of newline

-q, --quit quit

--raise bring the Geeqie window to the top

--selection-add=[<FILE>] adds the current file (or the specified file) to the current selec-
tion

--selection-clear clears the current selection

--selection-remove=[<FILE>] removes the current file (or the specified file) from the current
selection

-w, --show-log-window show log window

--slideshow-recurse=<FOLDER> start recursive slide show in FOLDER

-s, --slideshow toggle slide show
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--tell print filename [and Collection] of current image

-t, --tools toggle tools

-v, --version print version info

--view=<FILE> open FILE in new window

--display=DISPLAY X display to use

All other command line parameters are used as plain files if
they exist, or a URL or a folder. The name of a collection, with
or without either path or extension (.gqv) may be used.

If more than one folder is on the command line, only the last
will be used.

If more than one file is on the command line:

If they are in the same folder, that folder will be opened and
those files will be selected. If they are not in the same folder, a
new Collection containing those files will be opened.

To run Geeqie as a new instance, use: GQ_NEW_INS-
TANCE=y[es] geeqie Normally a single set of configura-
tion files is used for all instances. However, the environment
variables XDG_CONFIG_HOME, XDG_CACHE_HOME,
XDG_DATA_HOME can be used to modify this behav-
ior on an individual basis e.g. XDG_CONFIG_HOME=/tmp/
a XDG_CACHE_HOME=/tmp/b GQ_NEW_INSTANCE=y
geeqie

To disable Clutter use: GQ_DISABLE_CLUTTER=y[es] gee-
qie

To run or stop Geeqie in cache maintenance (non-GUI) mode
use: GQ_CACHE_MAINTENANCE=y[es] geeqie --help

User manual: https://www.geeqie.org/help/GuideIndex.html

: https://www.geeqie.org/help-pdf/help.pdf

BUGS

Please send bug reports and feedback to https://github.com/BestImageViewer/geeqie/issues

COPYRIGHT

Copyright (C) 1999-2004 by John Ellis. Copyright (C) 2004-2025 by The Geeqie Team. Use this
software at your own risk! This software released under the GNU General Public License. Please read
the COPYING file for more information.

Remote Keyboard Actions
The command:

geeqie --action=<action>

can be used to simulate keyboard actions. An example is:

geeqie --action="ZoomIn"
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The actions available are shown in the Edit/Preferences/Keyboard dialog. The two end columns are
relevant. The final component of the Accel column is the action code that should be used. The Tooltip
column provides a description of the action. Both columns can be sorted by clicking the header.

The available action codes may also be listed by:

geeqie --action-list

Keyboard and Mouse Shortcuts
The tables below shows the defaults for keyboard shortcuts. The current settings for shortcuts may be
found in the Keyboard Options dialogue.

Only the main window shortcuts can be redefined in Keyboard Options . The shortcuts in other win-
dows are fixed.

Note
In the list below, KP means KeyPad

Keyboard shortcuts in all windows, where relevant

Table 13.1. Standard keyboard shortcuts

Shortcut Mouse Action

F1 Help.

Menu Right-click Context menu.

F10 Right-click Context menu.

/ Search and Run Commands.

Main window programmable keyboard shortcuts

Table 13.2.  Main window keyboard shortcuts

Shortcut Action

Shift + O Image rotate Original state

Ctrl + W Close window

Shift + KP_Divide Connected Zoom 1:1

Shift + Z Connected Zoom 1:1

Shift + H Connected Fit Horizontally

Shift + W Connected Fit Vertically

Shift + KP_Multiply Connected Zoom to fit

Shift + X Connected Zoom to fit

Shift + KP_Add Connected Zoom in

plus Connected Zoom in

Shift + KP_Subtract Connected Zoom out

underscore Connected Zoom out

Ctrl + C Copy

Ctrl + X Cut to clipboard

Delete Move selection to Trash

KP_Delete Move selection to Trash
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Shortcut Action

Ctrl + D Move selection to Trash

Q Leave full screen

Escape Leave full screen

Ctrl + E Exif window

D Find duplicates

Home First Image

Ctrl + Home First Page of multi-page image

Shift + F Image Flip

V Full screen

F11 Full screen

F Full screen

F1 Help manual

Ctrl + H Hide file list

K Cycle through histogram channels

J Cycle through histogram modes

I Cycle through Overlay modes

Alt + K Keyword Autocomplete

End Last Image

Ctrl + End Last Page of multi-page image

Shift + M Image Mirror

Ctrl + M Move

C New collection

Ctrl + F New folder

Ctrl + N New window (default

Page_Down Next Image

KP_Page_Down Next Image

space Next Image

Ctrl + Page_Down Next Page of multi-page image

O Open collection

Ctrl + J Pan view

Shift + Delete Delete selection

Ctrl + O Preferences

Page_Up Previous Image

KP_Page_Up Previous Image

BackSpace Previous Image

Ctrl + Page_Up Previous Page of multi-page image

Shift + P Print

Ctrl + Q Quit

Alt + KP_0 Rating 0

Alt + KP_1 Rating 1

Alt + KP_2 Rating 2
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Shortcut Action

Alt + KP_3 Rating 3

Alt + KP_4 Rating 4

Alt + KP_5 Rating 5

Alt + KP_Subtract Rating -1

R Refresh

Ctrl + R Rename

Shift + R Image Rotate 180°

[ Rotate counterclockwise 90°

] Image Rotate clockwise 90°

Ctrl + S Save metadata

/ Search commands by keyword and run them

F3 Search

Ctrl + A Select all

Ctrl + Shift + I Invert Selection

Ctrl + Shift + A Select none

Ctrl + equal Slideshow Faster

P Pause slideshow

Ctrl + minus Slideshow Slower

Alt + Down Down Split Pane

Alt + Right Next Split Pane

Alt + Left Previous Split Pane

Alt + Up Up Split Pane

Ctrl + V View in new window

KP_Divide Zoom 1:1

Z Zoom 1:1

H Fit Horizontally

W Fit Vertically

KP_Multiply Zoom to fit

X Zoom to fit

KP_Add Zoom in

equal Zoom in

KP_Subtract Zoom out

minus Zoom out

A Toggle animation

Alt + X Toggle Exif rotate

L Float file list

Shift + G Toggle grayscale

grave Hide Bars and Files

Ctrl + grave Hide Selectable Bars

Shift + A Hide alpha channel

Shift + E Highlight over/under exposed
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Shortcut Action

Alt + R Rectangular Selection

Ctrl + K Info sidebar

Shift + S Sort manager

M Show Marks

S Toggle slideshow

T Show Thumbnails

Ctrl + I View Images as Icons

Ctrl + L View Images as List

Ctrl + T Toggle Folders View

E Split panes horizontal.

Y Single pane

U Split panes vertical

1...6 Toggle mark 1 ... 6

Ctrl +1...Ctrl +6 Select mark 1 ... 6

Collections window non-programmable keyboard
shortcuts

Table 13.3.  Collections window keyboard shortcuts

Shortcut Action

Ctrl +  C Copy

Ctrl +  M Move

Ctrl +  R Rename

Ctrl +  D Move selection to Trash

Ctrl +  W Close window

Delete Remove

Return View

V View in new window

Ctrl +  A Select all

Ctrl + Shift +  A Select none

Alt +  R Rectangular selection

space Select single file

Ctrl +  space Toggle select image

Ctrl +  L Append from file selection

A Append from collection

S Save collection

Ctrl +  S Save collection as

Ctrl +  T Show filename text

N Sort by name

D Sort by date

B Sort by size
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Shortcut Action

P Sort by path

Shift +  P Print

Alt +  A Append (Append collection dialog)

Alt +  D Discard (Close modified collection dialog)

Duplicates window non-programmable keyboard
shortcuts

Table 13.4.  Duplicates window keyboard shortcuts

Shortcut Action

Ctrl +  C Copy

Ctrl +  M Move

Ctrl +  R Rename

Ctrl +  D Move selection to Trash

Shift +  Delete Delete selection

Delete Remove

Ctrl +  Delete Clear

Ctrl +  A Select all

Ctrl + Shift +  A Select none

Ctrl +  T Toggle thumbs

Ctrl +  W Close window

Return View

V View in new window

C Collection from selection

Ctrl +  L Append list

0 Select none

1 Select group 1 duplicates

2 Select group 2 duplicates

Image window non-programmable keyboard shortcuts

Table 13.5.  Image view window keyboard shortcuts

Shortcut Action

Ctrl +  C Copy

Ctrl +  M Move

Ctrl +  R Rename

Ctrl +  D Move to Trash

Delete Move to Trash

Shift +  Delete Delete

Ctrl +  W Close window

Shift +  R Rotate 180°

Shift +  M Rotate mirror

89



Reference

Shortcut Action

Shift +  F Rotate flip

] Rotate counterclockwise 90°

[ Rotate clockwise 90°

Page_Up Previous

KP_Page_Up Previous

BackSpace Previous

B Previous

Page_Down Next

KP_Page_Down Next

space Next

N Next

equal Zoom in

plus Zoom in

minus Zoom out

X Zoom to fit

KP_Multiply Zoom to fit

Z Zoom 1:1

KP_Divide Zoom 1:1

1 Zoom 1:1

2 Zoom 2:1

3 Zoom 3:1

4 Zoom 4:1

7 Zoom 1:4

8 Zoom 1:3

9 Zoom 1:2

W Zoom fit window width

H Zoom fit window height

S Toggle slideshow

P Pause slideshow

R Reload image

F Full screen

V Fullscreen

F11 Fullscreen

I Image overlay

Escape Exit fullscreen

Escape Close window

Shift +  G Desaturate

Shift +  P Print
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Pan window non-programmable keyboard shortcuts

Table 13.6.  Pan view window keyboard shortcuts

Shortcut Action

Ctrl +  C Copy

Ctrl +  M Move

Ctrl +  R Rename

Ctrl +  D Move to Trash

Ctrl +  W Close window

Ctrl +  F Display Find search bar

Ctrl +  G Start search

Escape Exit fullscreen

Escape Hide Find search bar

equal Zoom in

plus Zoom in

minus Zoom out

Z Zoom 1:1

1 Zoom 1:1

KP_Divide Zoom 1:1

2 Zoom 2:1

3 Zoom 3:1

4 Zoom 4:1

7 Zoom 1:4

8 Zoom 1:3

9 Zoom 1:2

F Full screen

V Full screen

F11 Full screen

/ Display Find search bar

Left Scroll left

Right Scroll right

Up Scroll up

Down Scroll down

Shift +  Left Scroll left faster

Shift +  Right Scroll right faster

Shift +  Up Scroll up faster

Shift +  Down Scroll down faster

Page_Up Scroll display half screen up

Page_Down Scroll display half screen down

Home Scroll display half screen left

End Scroll display half screen right
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Search window non-programmable keyboard short-
cuts

Table 13.7.  Search window keyboard shortcuts

Shortcut Action

Ctrl +  C Copy

Ctrl +  M Move

Ctrl +  R Rename

Ctrl +  D Move selection to Trash

Shift +  Delete Delete selection

Delete Remove

Ctrl +  A Select all

Ctrl + Shift +  A Select none

Ctrl +  Delete Clear

Ctrl +  T Toggle thumbs

Ctrl +  W Close window

Return View

V View in new window

C Collection from selection

Ctrl +  Return Start/stop search

F3 Find duplicates

Mouse actions

Table 13.8. Mouse action shortcuts

Mouse Action

Left Click ,

Mouse Wheel down a

Next image.

Middle Click ,

Mouse Wheel up a2abaab

Previous image.

Left click and Drag a2abaab Pan image.

Ctrl + Mouse Wheel up Zoom image in.

Ctrl + Mouse Wheel down Zoom image out.

Mouse button 8 b Forward

Mouse button 9 b Back

Control + left-click Smooth scroll

Control + Shift + right-click Duplicates window only - show image technical
data

a Default Mouse wheel functions can be altered by changing the Mouse wheel scrolls image option.
bRequires a multi-button mouse.

92



Reference

Arrow keys actions

Table 13.9. Arrow key shortcuts

Shortcut Action

Arrow key Pan image.

Shift + Arrow key Pan Image faster.

Ctrl + Arrow key Pan to respective edge of image.

Alt + Right Arrow Next split pane.

Alt + Left Arrow Previous split pane.

Alt + Up Arrow Up or previous split pane.

Alt + Down Arrow Down or next split pane.

Thumbnails
Note

This page only refers the Geeqie thumbnail caching mechanism, the shared thumbnail cache
mechanism is described in Thumbnail Standards .

Format
Thumbnails are stored in PNG image format. The thumbnail name is the name of the source image
with “.png” appended.

The modification time (mtime) of the thumbnail is set to match the source file. Thumbnails are regen-
erated when the timestamps of the thumbnail and source file do not match.

Location
Thumbnails are stored in a location specified in Thumbnail Preferences .

The directory structure of the thumbnail cache duplicates that of the location of the source files.

Size
Geeqie allows the following sizes for thumbnails:

24x24, 32x32, 48x48, 64x64, 96x72, 96x96, 129x96, 128x128, 160x120, 160x160, 192x144,
192x192, 256x192, 256x256, custom

Custom size has a maximum of 512x512.

The thumbnail is scaled to fit within the preferred size maintaining the aspect ratio. Thumbnails are
not cached for images that are equal to or smaller than the preferred thumbnail size.

When a cached thumbnail's width and height do not match the preferred size, the thumbnail is regen-
erated.

Metadata Processing
This section describes the metadata reading and writing process.
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Metadata handling

Read algorithm

1. Read Exif, IPTC and XMP from the file.
2. Display this "raw" data in the Exif Window .
3. Read XMP sidecar or Geeqie private metadata file. This data will override the XMP data read from

the file.
4. Synchronise XMP data with Exif and IPTC data. This process corresponds to the section "Recon-

ciling metadata properties" as described in the XMP Specification .
• detect which of Exif and Xmp.exif is newer and copy the data in the appropriate direction
• detect which of IPTC and XMP is newer and copy the data in the appropriate direction

5. Use this "processed" data within Geeqie, with the exception of in the Exif Window

Metadata modification

• Metadata is written to a single file or group of files as specified in the Metadata tab of main Pref-
erences.

• Modifying the keywords, comment, orientation, etc. does not ask for confirmation, but immediately
modifies the metadata in memory and adds the file to "write queue"

• Writing of the queued changes is triggered either manually or as defined in Metadata. It is possible
to review the changes and exclude selected files.

Write algorithm

1. Exif and IPTC are updated from XMP (for example Exif.Image.Orientation is updated from Xm-
p.exif.orientation ). See XMP and IPTC4XMP specifications for the list of corresponding tags.

2. Try to write metadata in the order specified in the Metadata writing process section of Preferences.
3. After the first successful write attempt delete old metadata files in all possible locations.

Options that influence the process
File types with allowed sidecars are listed in the File Filters Options tab of the main Preferences.

Lua Extensions
Lua scripts allow the functionality of Geeqie to be extended. Lua scripts may only be used in conjunc-
tion with the Overlay Screen Display , List panes on the Info Sidebar, and the

geeqie --lua:

command line option.

Some knowledge of the Lua programming language is required.

Requirements
Use of Lua within Geeqie requires Lua to be installed. If you are compiling from sources, Lua func-
tionality will be available if the development files dependencies are met.
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If you are using a pre-compiled distribution, availability depends on the package maintainer.

How to use Lua

Lua scripts must be stored in a single folder as defined in Configuration Files and Locations .

A link to a Lua script must be inserted into the overlay template. Refer to the Overlay Screen Display
section of Window Options.

The full extent of the Lua language is available.

Geeqie Lua built-in functions

The following functions are built in to Geeqie:

Function Returns

Image:get_path() The full path of the file, including filename and
extension

Image:get_name() The full filename including extension

Image:get_extension The file extension including preceding dot

Image:get_date() The file date in Unix timestamp format.

Image:get_size() The file size in bytes

Image:get_marks() An integer representing the marks set for the file

Image:get_exif() A data structure containing the entire exif data

<exif_str>:get_datum("<exif_tag>") A single exif tag extracted from a structure output
by the above command

The keyword "Image" refers to the file currently being displayed by Geeqie.

Examples

The following example, which outputs the jpeg comment of a file, demonstrates the use of a built-in
function and how to call a system command from a Lua script:

        path=Image:get_path()
        commentfile=io.popen("exiv2 -p c \"" .. path .. "\"" )
        comment = commentfile:read("*a")
        commentfile:close()
        return (comment)
      

Note that it is necessary to have escape characters surrounding path and filenames.

The following example demonstrates how to extract exif data from a file:

        --Retrieve the DateTimeDigitized exif tag
        exif_structure = Image:get_exif();
        DateTimeDigitized =
             exif_structure:get_datum("Exif.Photo.DateTimeDigitized");
        return (os.date(DateTimeDigitized))
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Warning

Warning

Lua is a powerful programming language. Errors in script files, besides having undesirable
side-effects, may cause Geeqie to crash.

Lua API
The Lua API document [./lua-api/html/lua_8cc.html]

Configuration Files and Locations
The following data lists the locations Geeqie uses for various actions. The uppercase symbols are
environment variables. If they are not set on your system the fallback locations are listed in parentheses.

Geeqie will first attempt to load a configuration file from:

/etc/geeqie/geeqierc.xml

It will then continue with the following locations.

Most of Geeqie's configuration files are contained in the folder, and sub-folders of:

$XDG_CONFIG_HOME/geeqie/

($HOME/.config/geeqie/)

Geeqie's standard configuration file is:

.../geeqierc.xml

An alternative configuration file may be used by executing:

geeqie --config-load:<filename>

Saved window layout files are in the folder:

.../layouts

Geeqie-created desktop files used by Plugins are in the folder:

.../applications

Lua script files for Lua Extensions are in the folder:

.../lua

Historic data such as last several folders visited, bookmarks, and recently used collections, as well as
default print settings are contained in this text file:

.../history

Keyboard shortcut maps are contained in this text file:

.../accels

The location for Collections is in the folder:

$XDG_DATA_HOME/geeqie/collections

($HOME/.local/share/geeqie/collections)

Thumbnails are stored in a location specified in Thumbnail Preferences
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Metadata is stored either in the image file or in the location specified in Metadata

Similarity files are stored in the folder:

($HOME/.cache/geeqie/)

The safe delete folder is specified in the Safe Delete tab of main Preferences

File date types
Geeqie understands 4 types of file dates:

• Standard date (mtime) - The date the file contents were last modified, or when the file was created
if since unchanged.

• Status changed (ctime) - The date the file status was last changed. This includes change of owner,
change of read/write permission and change of contents.

• Exif date original (Exif.Photo.DateTimeOriginal) - For images from a digital camera, this is the
time the photo was taken.

• Exif date digitized (Exif.Photo.DateTimeDigitized) - For scanned images, this the time the scan
was made. For images from a digital camera, it may be identical to the above date.

XMP, Exif and IPTC
The tables below show the XMP, Exif and IPTC tags used by Geeqie.

Geeqie pre-formatted tags

Table 13.10. Pre-formatted tags

Geeqie Tag Exif tags used Description

formatted.Camera Exif.Image.Make

Exif.Image.Model

Exif.Image.Software

Camera and software name

formatted.DateTime Exif.Photo.DateTimeOriginal

Exif.Photo.SubSecTimeOrigi-
nal

Exif.Image.DateTime

Exif.Photo.SubSecTime

Image Date

formatted.ShutterSpeed Exif.Photo.ExposureTime

Exif.Photo.ShutterSpeedValue

Shutter speed in seconds (e.g.
1/60s)

formatted.Aperture Exif.Photo.Fnumber

Exif.Photo.ApertureValue

Aperture (e.g. f5.6)

formatted.ExposureBias Exif.Photo.ExposureBiasValue Exposure bias (e.g. +0.3)

formatted.ISOSpeedRating Exif.Photo.ISOSpeedRatings ISO sensitivity (e.g. 100)

formatted.FocalLength Exif.Photo.FocalLength Focal length

formatted.FocalLength35mm-
Film

Exif.Photo.FocalLength-
In35mmFilm

Exif.Photo.FocalLength

Focal length 35mm
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Geeqie Tag Exif tags used Description

Exif.Photo.FocalPlaneXResolu-
tion

Exif.Photo.FocalPlaneYResolu-
tion

Exif.Photo.FocalPlaneResolu-
tionUnit

Exif.Photo.PixelXDimension

Exif.Photo.PixelYDimension

formatted.SubjectDistance Exif.Photo.SubjectDistance Subject distance

formatted.Flash Exif.Photo.Flash Flash

formatted.Resolution Exif.Image.Xresolution

Exif.Image.Yresolution

Exif.Image.ResolutionUnit

Resolution

formatted.ColorProfile Exif.Image.InterColorProfile

Exif.Photo.ColorSpace

Exif.Iop.InteroperabilityIndex

Color profile

formatted.GPSAltitude Exif.GPSInfo.GPSAltitudeRef

Exif.GPSInfo.GPSAltitude

Altitude above sea level

formatted.GPSPosition Exif.GPSInfo.GPSLatitude

Exif.GPSInfo.GPSLatitudeRef

Exif.GPSInfo.GPSLongitude

Exif.GPSInfo.GPSLongitud-
eRef

Latitude, Longitude

formatted.localtime Exif.GPSInfo.GPSLatitude

Exif.GPSInfo.GPSLatitudeRef

Exif.GPSInfo.GPSLongitude

Exif.GPSInfo.GPSLongitud-
eRef

Exif.GPSInfo.GPSDateStamp

Exif.GPSInfo.GPSTimeStamp

Local time corrected for UTC
offset, DST correction a

formatted.timezone Exif.GPSInfo.GPSLatitude

Exif.GPSInfo.GPSLatitudeRef

Exif.GPSInfo.GPSLongitude

Exif.GPSInfo.GPSLongitud-
eRef

Timezone indicated by lat/long b
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Geeqie Tag Exif tags used Description

formatted.countryname Exif.GPSInfo.GPSLatitude

Exif.GPSInfo.GPSLatitudeRef

Exif.GPSInfo.GPSLongitude

Exif.GPSInfo.GPSLongitud-
eRef

ISO 3166 country name indicat-
ed by lat/long

formatted.countrycode Exif.GPSInfo.GPSLatitude

Exif.GPSInfo.GPSLatitudeRef

Exif.GPSInfo.GPSLongitude

Exif.GPSInfo.GPSLongitud-
eRef

ISO 3166 two-letter abbreviated
country name indicated by lat/
long

formatted.star_rating Xmp.xmp.Rating Rating shown as a set of # charac-
ters

a Refer to UTC and DST section.
b Refer to UTC and DST section.

Info sidebar panes

Table 13.11. Fixed panes

Tag Pane title

Xmp.dc.description Comment

Xmp.dc.subject Keywords

Xmp.dc.title Title

Xmp.xmp.Rating Rating

Xmp.photoshop.Headline Headline

Table 13.12. Location and GPS pane

Tag Field

formatted.GPSPosition GPS position

formatted.GPSAltitude GPS altitiude

formatted.timezone Time zone

Xmp.photoshop.Country Country

Xmp.iptc.CountryCode Country Code

Xmp.photoshop.State State

Xmp.photoshop.City City

Xmp.iptc.Location Location

Table 13.13. Copyright pane

Tag Field

Xmp.dc.creator Creator

Xmp.dc.contributor Contributor

Xmp.dc.rights Rights
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Table 13.14. Exif pane

Tag Field

formatted.Camera Camera

formatted.DateTime Date

formatted.localtime Local time

formatted.ShutterSpeed Shutter speed

formatted.Aperture Aperture

formatted.ExposureBias Exposure bias

formatted.ISOSpeedRating ISO sensitivity

formatted.FocalLength Focal length

formatted.FocalLength35mmFilm Focal length 35mm

formatted.SubjectDistance Subject distance

formatted.Flash Flash

formatted.Resolution Resolution

formatted.ColorProfile Color profile

Exif.Photo.ExposureProgram Exposure Program

Exif.Photo.MeteringMode Metering Mode

Exif.Photo.LightSource Light Source

Exif IPTC alternative keys

Table 13.15. Conversion table

Tag Field

Xmp.tiff.Orientation Exif.Image.Orientation

Xmp.dc.title Iptc.Application2.ObjectName

Xmp.photoshop.Urgency Iptc.Application2.Urgency

Xmp.photoshop.Category Iptc.Application2.Category

Xmp.photoshop.SupplementalCategory Iptc.Application2.SuppCategory

Xmp.dc.subject Iptc.Application2.Keywords

Xmp.iptc.Location Iptc.Application2.LocationName

Xmp.photoshop.Instruction Iptc.Application2.SpecialInstructions

Xmp.photoshop.DateCreated Iptc.Application2.DateCreated

Xmp.dc.creator Iptc.Application2.Byline

Xmp.photoshop.AuthorsPosition Iptc.Application2.BylineTitle

Xmp.photoshop.City Iptc.Application2.City

Xmp.photoshop.State Iptc.Application2.ProvinceState

Xmp.iptc.CountryCode Iptc.Application2.CountryCode

Xmp.photoshop.Country Iptc.Application2.CountryName

Xmp.photoshop.TransmissionReference Iptc.Application2.TransmissionReference

Xmp.photoshop.Headline Iptc.Application2.Headline

Xmp.photoshop.Credit Iptc.Application2.Credit

Xmp.photoshop.Source Iptc.Application2.Source
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Tag Field

Xmp.dc.rights Iptc.Application2.Copyright

Xmp.dc.description Iptc.Application2.Caption

Xmp.photoshop.CaptionWriter Iptc.Application2.Writer

Supported File Formats
3FR ANI ARW AVIF BMP CR2 CR3 CRW CUR DDS DJVU DNG ERF EXR GIF GQV HEIC
HEIF ICO JP2 JPE JPEG JPG JPS JXL KDC MEF MOS MPO MRW NEF ORF PBM PDF PEF
PGM PNG PNM PPM PSD QIF QTIF RAF RAW RW2 SCR SR2 SRF SVG SVGZ TGA TIF TIFF
WEBP XBM XPM

Images in archive files (.ZIP, .TAR etc) can be displayed.

Animated GIF and WEBP files are supported.

Refer to Additional pixbuf loaders for additional information.

Preview and thumbnails of video clips can be displayed. Clips can be run via a defined external pro-
gram - see Play video by left click on image .

Similarity Algorithms
This function is intended to find images with similar color content. For example when an image was
saved at different compression levels or dimensions (scaled down/up) the contents are similar, but
these files do not match by file size, dimensions, or checksum.

A 32 x 32 array is created for each image. Imagine the image cut into 1024 rectangles, 32 across and
32 down.

For each array element, the average value of all the red and the green and the blue pixels is computed
and stored in the array. Therefore the array represents the average color of each corresponding part
of the image.

This data is stored in a file with the same name is the image and with the extension .sim. It is stored in
the same location as thumbnails. If many images are to be compered, run-time is reduced by having
these .sim files already created. This can be done via Edit/Cache Maintenance or by the command line
instruction: geeqie --cache-maintenance <path>

Standard Algorithm
To compare two images, each array element of each image is compared in turn. The computed value is
the percent match of all elements of the two images. For this, simple comparisons are used - basically
the value is an average of the corresponding array differences.

The value computed is in the range 0% to 100%.

        100% for exact matches (an image is compared to itself)
        0% for exact opposite images (compare an all black to an all white image)
      

Generally only a match of >85% is significant at all, and >95% is useful to find images that have been
re-saved to other formats, dimensions, or compression.

If the Ignore Orientation checkbox on the Duplicates window is selected, images are also checked for
90°, 180°, 270°, rotations and mirror and flip. This will increase run-time.
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Alternate Algorithm
The alternate algorithm can be enabled on the Advanced tab of Preferences.

It does not check for rotations, mirror or flip.

After comparing two array elements of two images, the difference from the preceding element com-
parison is included in the computation.

There is an additional option to reduce the fingerprint to grayscale before comparisons are made.

Additional pixbuf loaders
Geeqie can display files for which there are existing pixbuf loaders. In addition to the standard ones
included with most distributions, the following loaders may also be available to you.

However, in some cases you are required to compile and install them yourself.

JP2/JPC/JPX/J2K/JPF
If your distribution has the libpixbufloader-jasper.so loader, these file formats will also be displayed.

Standard Plugins
The following plugins are supplied as standard with Geeqie.

Apply the orientation to image content
This command affects only jpeg, tiff and png files. The image file on disk is rotated to the orientation
as specified by its Exif Orientation tag.

Warning

External commands exiftran, exiv2 and mogrify, are used to implement this command.

This item is displayed in the Edit/Orientation menu.

Camera import
Imports images from an attached camera to the current folder. If a file with the same name already
exists it will not be overwritten, and the new image will not be downloaded.

File names on digital cameras are not necessarily unique. In some cases the same file name can exist
in more than one sub-folder on the camera. As existing images will not be overwritten, subsequent
files of the same name will not be downloaded. In this case a dialog will be shown to warn you of this.

You may use the gphoto2 option --filename option to ensure that all filenames are unique
when downloading. Refer to the gphoto2 documentation. [http://www.gphoto.org/doc/manual/ref-
gphoto2-cli.html]

This item is displayed in the Plugins menu.

Exif datetime to file
Sets the file datetime (mtime) to the Exif.Image.DateTimeOriginal value. If the exif tag does not exist,
no action is taken.
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This may be useful if you wish to sort on Exif.Image.DateTimeOriginal. This requires that the metadata
for all files in the folder must be read each time. This is time consuming. If this operation is carried
out when images are imported from the camera, future sorting can utilize file datetime which will be
much faster.

This item is displayed in the Plugins menu.

Export jpeg
Extracts an embedded jpeg from a raw image to a file in the /tmp folder. If you wish to to keep this
image, it must be copied or moved.

If jpgicc is installed, the image will be colour-corrected for the currently selected rendering intent.

This item is displayed in the Plugins menu.

Image crop
If rectangle coordinates have been set by Edit/Draw Rectangle , a cropped image will be stored in
the /tmp folder. If you wish to to keep this image, it must be copied or moved.

This item is displayed in the Plugins and Edit menus.

Open With
Call the standard GTK application chooser for a single file.

This item is also displayed in the File menu.

Random image
Selects and displays a random image from a list of all images in Collections and the currently displayed
folder.

This item is displayed in the Plugins menu.

Resize image
Reduce the size of an image.

Table 13.16. Resize image options

Option Meaning

Required size kB desired output file size in kilobytes

Tolerance % tolerance or allowed size of result greater than de-
sired size expressed as percent of desired

Max. iterations maximum number of iterations to stop

Copy if unchanged copy to output when not downsizing and no image
format change

Strip metadata strip all meta data

Show computation show the values of each iteration

Open output file in Geeqie on successful conversion set Geeqie focus to the
file
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This plugin uses the Downsize script. The original may be found here. [http://www.fmwconcept-
s.com/imagemagick/downsize/index.php] It is subject to the following copyright:

      Copyright © Fred Weinhaus

      My scripts are available free of charge for non-commercial (non-profit) use, ONLY.

      For use of my scripts in commercial (for-profit) environments
      or non-free applications,
      please contact me (Fred Weinhaus) for licensing arrangements.
      My email address is fmw at alink dot net.

      If you:
      1) redistribute,
      2) incorporate any of these scripts into other free applications or
      3) reprogram them in another scripting language, then you must contact me for permission,
      especially if the result might be used in a commercial or for-profit environment.

      Usage, whether stated or not in the script, is restricted to the above licensing
      arrangements. It is also subject, in a subordinate manner, to the ImageMagick license, which
      can be found at: http://www.imagemagick.org/script/license.php
    

Symlink
Creates a symbolic link on the selected files. If a file has sidecars, they will also be symlinked.

This item is displayed in the File menu.

Tethered photography
If a camera is connected to the computer via USB, photos taken are immediately downloaded to the
current folder and displayed on the computer.

If a file already exists with the same name, it is not overwritten but the download will not take place.

Auto-rename can be achieved with the --filename option of gphoto2.

In file $HOME/.config/gphoto2/settings , set the option: gphoto2=filename=<see
the gphoto2 manual>

This item is displayed in the Plugins menu.

UTC and Daylight Saving Time (DST)
Geeqie can display the local time at which a photo was taken, adjusted for UTC offset and Daylight
Saving Time.

If the image exif data contains the required parameters (see Pre-formatted tags ), Geeqie will use the
latitude and longitude to determine which timezone the image was taken in.

The UTC offset and Daylight Saving Time Correction for that timezone, combined with the GPS UTC
value, will then be used to compute the correct local time.

This value may be displayed in either the Info Sidebar or Overlay Screen Display by using the para-
meter formatted.localtime
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The timezone for the image may also be displayed by using the parameter formatted.timezone .

Decoding Latitude and Longitude
This section is relevant to geocode searches and the map display of Geeqie.

The result of some internet or other searches for placenames can contain a latitude and longitude
embedded in a text string. For example an openstreetmap.org search can give a URL such as:

https://www.openstreetmap.org/search?
query=51.5542%2C-0.1816#map=12/51.5542/-0.1818

If you paste such a string into the search box, the latitude/longitude can be automatically extracted
and used as the origin of the search.

You may also drag-and-drop a URL of this type onto the map to cause the map to be re-centered.

This feature uses the file:

/usr/local/lib/geeqie/geocode-parameters.awk

You may create your own decodes by using the above file as an example, and storing the file in:

~/.config/geeqie/applications/geocode-parameters.awk

If a successful decode was not made from the first file, your local version will then be used.

Standards
Desktop files: https://specifications.freedesktop.org/desktop-entry-spec/desktop-entry-spec-lat-
est.html

Desktop files: https://standards.freedesktop.org/desktop-entry-spec/ [https://specifications.freedesk-
top.org/desktop-entry-spec/latest/]

XMP: https://developer.adobe.com/xmp/docs/XMPSpecifications

IPTC4XMP: http://xml.coverpages.org/IPTC-CoreSchema200503-ImplGuideLines3.pdf

Pango mark up: https://docs.gtk.org/Pango/pango_markup.html

Thumbnails: https://www.freedesktop.org/wiki/Specifications/thumbnails/

Perl Compatible Regular Expressions
The Filename and Comment sections on the search window use Perl Compatible Regular Expres-
sions [https://en.wikipedia.org/wiki/Perl_Compatible_Regular_Expressions] . In general use there are
a number of differences to the wildcard expansion used on the command line:

• Use "." and not "?" for a single character.

• Use "abc.*ghk" and not "abc*ghk" for multiple characters

• Use "\." to represent the dot in a file extension

• Use "(?i)" to make the following characters case-insensitive

105

https://specifications.freedesktop.org/desktop-entry-spec/desktop-entry-spec-latest.html
https://specifications.freedesktop.org/desktop-entry-spec/desktop-entry-spec-latest.html
https://specifications.freedesktop.org/desktop-entry-spec/latest/
https://specifications.freedesktop.org/desktop-entry-spec/latest/
https://specifications.freedesktop.org/desktop-entry-spec/latest/
https://developer.adobe.com/xmp/docs/XMPSpecifications
http://xml.coverpages.org/IPTC-CoreSchema200503-ImplGuideLines3.pdf
https://docs.gtk.org/Pango/pango_markup.html
https://www.freedesktop.org/wiki/Specifications/thumbnails/
https://en.wikipedia.org/wiki/Perl_Compatible_Regular_Expressions
https://en.wikipedia.org/wiki/Perl_Compatible_Regular_Expressions
https://en.wikipedia.org/wiki/Perl_Compatible_Regular_Expressions


Chapter 14. Useful Software
This is a list of other software that users might find useful in conjunction with Geeqie.

Entangle
Tethered photography: https://entangle-photo.org/

Photini
Digital photograph metadata editor: https://photini.readthedocs.io/en/latest/

Unison
Unison allows two replicas of a collection of files and directories to be stored on different hosts (or
different disks on the same host), modified separately, and then brought up to date by propagating
the changes in each replica to the other. It is available in some distributions. This is the project site:
https://github.com/bcpierce00/unison/

Geeqie Cache Maintenance
Command line program to automatically create or update thumbnails and similarity data: gee-
qie-cache-maintenance

Keyword Merge
This program will merge the keyword tree of one Geeqie configuration file into another. The key-
word trees are simply concatenated. When Geeqie loads the resulting configuration file, any duplicates
are discarded: keyword_merge.sh [https://raw.githubusercontent.com/BestImageViewer/geeqie/mas-
ter/scripts/keyword_merge.sh]

Install Geeqie from sources on Debian
This script will clone the Geeqie repository, fulfill all dependencies, and install Geeqie on a
Debian based system: geeqie-install-debian.sh [https://raw.githubusercontent.com/BestImageView-
er/geeqie/master/geeqie-install-debian.sh]

Generic install script
This script will install Geeqie to a defined location, and will run under any system. However, it is left
to you to make sure dependencies are fulfilled: build-geeqie [https://raw.githubusercontent.com/pixl-
sus/Scripts/master/build-geeqie]

Decoder for .sim files
This program is unlikely to be of interest to most users. It shows a summary of the contents of a .sim
file. (Requires perl to be installed): decode_sim [https://raw.githubusercontent.com/BestImageView-
er/geeqie/master/scripts/decode_sim]
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Chapter 15. Frequently Asked
Questions

Move to Trash failed

How do I fix move to trash failed?
It appears that some distributions will only trash files that are in the same filesytem as where the Trash
bin is located.

The location of the Trash bin for some systems is $HOME/.local/share/Trash .

If you attempt to trash a file not in this filesystem, an attempt is made to find directory <top of
filesystem>/.Trash-<uid> where <uid> is your user id (in a terminal type id to display
it). If this directory does not exist, then the action will fail.

You may create this directory and set write access to it as follows:

cd to the directory where the file to be deleted is

df --human-readable . (Note the dot!) The "Mounted on" column shows the top of the filesys-
tem.

cd <the top of the filesystem shown above>

sudo mkdir .Trash-<uid>

sudo chown <your user name> .Trash-<uid>

sudo chmod u+rwx .Trash-<uid>

Image viewing

Limiting enlargement of images
How do I keep images smaller than the visible area from enlarging when the zoom is set to “fit to
window”?

In the Preferences Image dialog , disable “Allow enlargement of image for zoom to fit”.

Command line

How do I open an image in an existing Geeqie applica-
tion ?

Use command line options to send commands to an existing Geeqie instance, for a list of commands
supported by the remote switch run:
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geeqie --help

Setting the slide show delay
How do I set the slide show delay when starting Geeqie in slide show from the command line ?

The delay can not be set when used with the standard --slideshow command line switch, as --slideshow
uses the delay stored in the configuration file.

For this, use the remote command --slideshow to start the slide show after setting the delay with --
delay=. The order of the command line is important. For example for a 12 second slide show delay use:

geeqie --delay=12 --slideshow

Note that if geeqie is running prior to this command, the slide show should also be stopped prior to
changing the delay:

geeqie --slideshow --delay=12 --slideshow

Miscellaneous

How can I save and restore multiple Geeqie windows
The option Exit program when this window is closed provides this facility.

I want to be able to edit images with Geeqie
Geeqie is an image viewer . There is, and never will be, a plan to add editing features. I recommend
gimp for image editing.

Exif Auto Rotation

How do the Exif auto-rotation commands work?
Image auto-rotation works in either of two modes, set by Write altered image orientation to the meta-
data option.

Write altered image orientation to the metadata - not set:

If you change the orientation of an image using any of the available commands, the image will always
be displayed in the modified orientation. This new orientation is stored in temporary data structures
associated with each image file. When Geeqie closes, these changes will be lost.

Warning

It is not possible to determine if the image as displayed is the original image or one which
has been temporarily rotated.

If the option Auto rotate image using EXIF information is selected, any images which have Exif
orientation data will also be shown rotated. However, any rotation you have selected manually will
always over-ride the embedded Exif rotation value.
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Write altered image orientation to the metadata - set:

If you change the orientation of an image using any of the available commands, this new orientation
is stored in a metadata write queue.

If the option Auto rotate image using EXIF information is selected, any images which have Exif
orientation data will be shown rotated, including any in the metadata write queue.

However if the option Auto rotate image using EXIF information is not selected, no images will be
auto-rotated. If you have manually rotated any images, the metadata write icon on the status bar will
alert you to that fact. Clicking the icon will give a list of the modified files.

Dark Mode

How to set Geeqie to use a dark mode
If Geeqie does not automatically change mode when a style is changed, use the following as an example
to start Geeqie:

GTK_THEME=Adwaita:dark geeqie
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Chapter 16. Licence
The Geeqie program is released under the "GNU General Public License", the complete GNU GPL
text can be found in the COPYING file included with each Geeqie release.

This Geeqie documentation is released under the GNU Free Documentation License.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free
Documentation License, Version 1.2 or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
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Chapter 17. Credits
Geeqie is maintained by The Geeqie Team (Colin Clark, Klaus Ethgen, Laurent Monin, Petr Ostadal,
Vladimir Nadvornik and others).

This software is a fork of GQview project by John Ellis.

The ever growing list of contributors and language translators can be found in the README file
included with the latest release of the program.

The Credits can also be viewed by selecting the Credits button located in the About dialog (open Help
Menu, select About, click Credits... button).
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Chapter 18. GNU Free Documentation
License

                    GNU GENERAL PUBLIC LICENSE
                       Version 2, June 1991

 Copyright (C) 1989, 1991 Free Software Foundation, Inc.,
 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
 Everyone is permitted to copy and distribute verbatim copies
 of this license document, but changing it is not allowed.

                            Preamble

  The licenses for most software are designed to take away your
freedom to share and change it.  By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.  This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it.  (Some other Free Software Foundation software is covered by
the GNU Lesser General Public License instead.)  You can apply it to
your programs, too.

  When we speak of free software, we are referring to freedom, not
price.  Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.

  To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

  For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have.  You must make sure that they, too, receive or can get the
source code.  And you must show them these terms so they know their
rights.

  We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

  Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software.  If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.

  Finally, any free program is threatened constantly by software
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patents.  We wish to avoid the danger that redistributors of a free
program will individually obtain patent licenses, in effect making the
program proprietary.  To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.

  The precise terms and conditions for copying, distribution and
modification follow.

                    GNU GENERAL PUBLIC LICENSE
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

  0. This License applies to any program or other work which contains
a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License.  The "Program", below,
refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it,
either verbatim or with modifications and/or translated into another
language.  (Hereinafter, translation is included without limitation in
the term "modification".)  Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope.  The act of
running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the
Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

  1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License
along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.

  2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

    a) You must cause the modified files to carry prominent notices
    stating that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in
    whole or in part contains or is derived from the Program or any
    part thereof, to be licensed as a whole at no charge to all third
    parties under the terms of this License.

    c) If the modified program normally reads commands interactively
    when run, you must cause it, when started running for such
    interactive use in the most ordinary way, to print or display an
    announcement including an appropriate copyright notice and a
    notice that there is no warranty (or else, saying that you provide
    a warranty) and that users may redistribute the program under
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    these conditions, and telling the user how to view a copy of this
    License.  (Exception: if the Program itself is interactive but
    does not normally print such an announcement, your work based on
    the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole.  If
identifiable sections of that work are not derived from the Program,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works.  But when you
distribute the same sections as part of a whole which is a work based
on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.

In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.

  3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable
    source code, which must be distributed under the terms of Sections
    1 and 2 above on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three
    years, to give any third party, for a charge no more than your
    cost of physically performing source distribution, a complete
    machine-readable copy of the corresponding source code, to be
    distributed under the terms of Sections 1 and 2 above on a medium
    customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer
    to distribute corresponding source code.  (This alternative is
    allowed only for noncommercial distribution and only if you
    received the program in object code or executable form with such
    an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it.  For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to
control compilation and installation of the executable.  However, as a
special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering
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access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

  4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License.  Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.

  5. You are not required to accept this License, since you have not
signed it.  However, nothing else grants you permission to modify or
distribute the Program or its derivative works.  These actions are
prohibited by law if you do not accept this License.  Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

  6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions.  You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.

  7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License.  If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all.  For example, if a patent
license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices.  Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.
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This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

  8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded.  In such case, this License incorporates
the limitation as if written in the body of this License.

  9. The Free Software Foundation may publish revised and/or new versions
of the General Public License from time to time.  Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any
later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free
Software Foundation.  If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software
Foundation.

  10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the author
to ask for permission.  For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this.  Our decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of promoting the sharing and reuse of software generally.

                            NO WARRANTY

  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

                     END OF TERMS AND CONDITIONS

            How to Apply These Terms to Your New Programs
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  If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.

  To do so, attach the following notices to the program.  It is safest
to attach them to the start of each source file to most effectively
convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

    one line to give the program's name and a brief idea of what it does.
    Copyright (C) year  name of author

    This program is free software; you can redistribute it and/or modify
    it under the terms of the GNU General Public License as published by
    the Free Software Foundation; either version 2 of the License, or
    (at your option) any later version.

    This program is distributed in the hope that it will be useful,
    but WITHOUT ANY WARRANTY; without even the implied warranty of
    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
    GNU General Public License for more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author
    Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'.
    This is free software, and you are welcome to redistribute it
    under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may
be called something other than `show w' and `show c'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer" for the program, if
necessary.  Here is a sample; alter the names:

  Yoyodyne, Inc., hereby disclaims all copyright interest in the program
  `Gnomovision' (which makes passes at compilers) written by James Hacker.

  signature of Ty Coon, 1 April 1989
  Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Lesser General
Public License instead of this License.
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